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Parallels Desktop Upgrade to Windows 7 allows you to smoothly upgrade Windows XP and 
Windows Vista to Windows 7 without losing your files and programs. 

Note: In this guide, only Windows XP is mentioned, however, all the information is also 
relevant to Windows Vista. 

In This Chapter 
About Parallels Desktop Upgrade to Windows 7.................................................................. 5 
About This Guide.................................................................................................................. 6 
Getting Help .......................................................................................................................... 8 
Feedback ............................................................................................................................... 8 
Acknowledgements ............................................................................................................... 9 
 
 

About Parallels Desktop Upgrade to 
Windows 7 

Parallels Desktop Upgrade to Windows 7 is a virtualization solution that enables you to perform 
the upgrade from Windows XP or Windows Vista to Windows 7: 

 If you have a Windows XP computer (or a Windows Vista computer), Parallels Desktop 
Upgrade to Windows 7 will help you smoothly upgrade to Windows 7 without losing your 
files and programs. 

 If you have a Windows XP computer (or a Windows Vista computer) and a Windows 7 
computer, Parallels Desktop Upgrade to Windows 7 will help you transfer all your files and 
programs from the computer running Windows XP (or Windows Vista) to the computer 
running Windows 7. 

 If you already upgraded your Windows XP (or Windows Vista) computer to Windows 7 
yourself, Parallels Desktop Upgrade to Windows 7 will help you restore the Windows XP 
(or Windows Vista) files and programs from the Windows.old folder. 

During the aforementioned upgrade, transfer and restore procedures, Parallels Desktop Upgrade 
to Windows 7 will create a Windows XP virtual machine (or a Windows Vista virtual machine) 
on the computer running Windows 7. If any of the transferred or restored programs are not 
supported in Windows 7, you will be able to launch them in this virtual machine. 

Note: In this guide, only Windows XP is mentioned, however, all the information is also 
relevant to Windows Vista. 
 

C H A P T E R  1  

Introduction 
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About This Guide 
This guide is aimed at a wide range of users who want to use Parallels Desktop Upgrade to 
Windows 7 to move from Windows XP to Windows 7. In this guide, you will find the necessary 
information on how to work with the Windows XP virtual machine and configure Parallels 
Desktop Upgrade to Windows 7. 

Abbreviations Used in the Text 

The following abbreviations are used in the guide: 

 OS is used instead of operating system in long sentences where using it will not change the 
meaning of the sentence. 

 VM is used instead of virtual machine in long sentences where using it will not change the 
meaning of the sentence. 

Definitions 

Primary operating system (primary OS): In this guide, this term is used to refer to the operating 
system that controls the input/output devices of the computer and is loaded when the physical 
computer is turned on. 

Guest operating system (guest OS): The term is used to refer to an operating system that runs 
under the virtual machine control. 
 

Organization of This Guide 
This guide is organized into the following chapters: 

 Introduction (p. 5) (You are reading it now). Provides basic information about the product 
and this guide. 

 Virtual Machine Technology Basics (p. 10). Provides information on the specification and 
technologies of the virtual machine. 

 Principles of Working with Parallels Desktop Upgrade to Windows 7 (p. 13). Provides basic 
information on how to work with Parallels Desktop Upgrade to Windows 7. 

 Working in the Virtual Machine (p. 39). Provides basic information on how to work with the 
virtual machine. 

 Configuring the Virtual Machine (p. 58). Provides information on how to change the virtual 
machine configuration. 

 Troubleshooting and Limitations (p. 101). Provides solutions for some of the known issues. 
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Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it. 

The table below presents the existing formatting conventions. 

Formatting convention Type of Information Example 
Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the Resources tab.  

Special Bold 

 Titles of chapters, sections, and 
subsections. 

Read the Basic Administration chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to designate 
a command-line placeholder, 
which is to be replaced with a 
real name or value. 

These are the so-called EZ templates. 

To destroy a Container, type vzctl 
destroy ctid. 

Monospace The names of commands, files, 
and directories. 

Use vzctl start to start a 
Container. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

Saved parameters for Container 
101 

Monospace Bold What you type, as contrasted 
with on-screen computer 
output. 

# rpm –V virtuozzo-release 

Key+Key Key combinations for which 
the user must press and hold 
down one key and then press 
another. 

Ctrl+P, Alt+F4 

Besides the formatting conventions, you should also know about the document organization 
convention applied to Parallels documents: chapters in all guides are divided into sections, 
which, in their turn, are subdivided into subsections. For example, About This Guide is a section, 
and Documentation Conventions is a subsection. 
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Getting Help 
Parallels Desktop Upgrade to Windows 7 offers several options for accessing necessary 
information: 

 Parallels Desktop Upgrade to Windows 7 User's Guide. This document contains extensive 
information about the Windows XP virtual machine, its usage, and troubleshooting. You can 
access the guide by choosing Parallels Desktop Help from the Parallels Desktop Upgrade to 
Windows 7 Help menu. 

 Online documentation. The PDF documentation for Parallels Desktop Upgrade to Windows 
7 and other Parallels products. To open the online documentation page, choose Online 
Documentation from the Help menu. 

 Parallels Command Line Reference Guide. This document contains information on using the 
prlctl command line utility designed to manage Parallels Desktop Upgrade to Windows 7 
and its virtual machines from command line. To access the document, go to the Online 
documentation page on our website. 

 Parallels API references and the SDK programmer's guide. These guides are mainly aimed 
at IT-professionals and can be found on the Online documentation page on our website. 

 Context-sensitive help. You can open a help page for the currently viewed window on your 
computer by pressing F1. 

 Parallels website (http://www.parallels.com). Explore the Support web page that includes 
product help files and the FAQ section. 

 Parallels Knowledge Base (http://kb.parallels.com/). This online resource includes valuable 
articles about using Parallels Desktop Upgrade to Windows 7 and other Parallels products. 

 

Feedback 
If you spot a typo in this guide, or if you have thought of a way to make this guide better, you 
can share your comments and suggestions with us by completing the documentation feedback 
form on our the website (http://www.parallels.com/en/support/usersdoc/). 

 

 
 

http://www.parallels.com/�
http://kb.parallels.com/�
http://www.parallels.com/en/support/usersdoc/�
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This chapter provides a brief description of the Windows XP virtual machine, its specifications, 
and the underlying technology. 

In This Chapter 
Virtual Machine Technology Overview................................................................................ 10 
Parallels Virtual Machine...................................................................................................... 11 
 
 

Virtual Machine Technology 
Overview 

The Parallels Desktop Upgrade to Windows 7 software is based on the virtual machine 
technology that allows you to share the hardware resources of the physical computer between 
the primary operating system (the operating system installed on this physical computer) and 
multiple virtual machines running on this computer. 

The virtual machine technology can be successfully used on computers that support the Intel 
virtualization technology (Intel VT-x). This technology allows Parallels Desktop Upgrade to 
Windows 7 to emulate virtual processors inside virtual machines. 

Intel VT-x implemented in the architecture of the new Intel processors is specially developed for 
platforms running multiple operating systems. VT-x processors allow more precise emulation of 
virtual processors. To learn more about Intel virtualization technology, visit the Intel website. 
 

C H A P T E R  2  

Virtual Machine Technology Basics 
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Parallels Virtual Machine 
Taking the best from the virtual machine and Intel virtualization technologies, Parallels Desktop 
Upgrade to Windows 7 enables you to create virtual machines with a variety of virtual hardware 
devices. 

A Parallels virtual machine works like a stand-alone computer with the following hardware: 

CPU 1-core Intel CPU 

Motherboard Intel i965 chipset based motherboard 

RAM 

Up to 8 GB of RAM 

 

Video Adapter VGA and SVGA with VESA 3.0 compatible Video Adapter 

Video RAM Up to 256 MB of Video RAM 

Floppy Disk Drive 
1.44 MB Floppy Disk Drive mapped to an image file or to a 
physical floppy drive. 

IDE Devices Up to 4 IDE devices 

 Hard Disk Hard Disk Drive mapped to an image file (up to 2 TB each) 

 CD/DVD-ROM Drive 
CD/DVD-ROM drive mapped to a physical drive or to an 
image file 

SCSI Devices Up to 15 SCSI devices 

 Hard Disk Hard Disk Drive mapped to an image file (up to 2 TB each) 

 Generic SCSI Device Generic SCSI device 

Network Interfaces 
Up to 16 Network interfaces including Ethernet virtual 
network card compatible with RTL8029 

Serial (COM) Ports 
Up to 4 Serial (COM) ports, mapped to a socket or to an 
output file 

Parallel (LPT) Ports 
Up to 3 Parallel (LPT) ports, mapped to output file, to a real 
port, or to a printer 

Sound Card AC'97-compatible Sound Card, sound recording support 

Keyboard Generic PC keyboard 

Mouse PS/2 wheel mouse 
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USB Up to 8 USB 2.0 and up to 8 USB 1.1 devices 

The virtual machine is stored in the primary OS as a bundle of files (.pvm) that contains the 
virtual machine configuration file (.pvs), the virtual hard disk file (.hdd), and other files of the 
virtual machine. 

A virtual machine may have the following files: 

.pvm A bundle that contains the virtual machine files. 

.pvs A virtual machine configuration file. It defines hardware and resources 
configuration of a virtual machine. The configuration file is generated 
when the virtual machine is created. 

.hdd A bundle of files that represents a virtual hard disk of a Parallels virtual 
machine. When you create a virtual machine, you can create it with a 
new virtual hard disk or use an existing one. 

.iso An image file of a CD or DVD disc. Virtual machines treat ISO images 
as real CD/DVD discs. 

.fdd A floppy disk image file. Virtual machines treat FDD images as real 
diskettes. 

.txt Output files for serial and parallel ports. The output .txt files are 
generated when a serial or parallel port connected to an output file is 
added to the virtual machine configuration. 
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This chapter provides basic information about how to work with Parallels Desktop Upgrade to 
Windows 7 after you moved from Windows XP to Windows 7. 

In This Chapter 
Activating Parallels Desktop Upgrade to Windows 7........................................................... 14 
Registering Parallels Desktop Upgrade to Windows 7 ......................................................... 15 
Updating Parallels Desktop Upgrade to Windows 7............................................................. 16 
Interface Basics ..................................................................................................................... 19 
Setting Parallels Desktop Upgrade to Windows 7 Preferences............................................. 25 
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Principles of Working with Parallels 
Desktop Upgrade to Windows 7 
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Activating Parallels Desktop 
Upgrade to Windows 7 

To activate Parallels Desktop Upgrade to Windows 7, do the following: 

1 Choose Activate Product from the Help menu. 

2 Type the activation key into the corresponding field: 

 

3 Click OK when finished. 
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Registering Parallels Desktop 
Upgrade to Windows 7 

After you activated a copy of Parallels Desktop Upgrade to Windows 7 with your activation 
key, we strongly recommend you to register Parallels Desktop Upgrade to Windows 7. With 
registration, you will be able to: 

 Download and install the latest Parallels Desktop Upgrade to Windows 7 updates. 
 Create a backup copy of the product key on the Parallels web server and restore it at any 

time. 
 Contact the Parallels support team. 
 Stay informed about Parallels news and announcements. 

All these services, including the product key backup, are free of charge for the registered users 
of Parallels Desktop Upgrade to Windows 7. 

To initiate the registration procedure, select Register Product from the Help menu. 

The Registration Procedure 
1 In the registration dialog, please provide your name, e-mail, and address in the 

corresponding fields. You should also specify where you are going to use Parallels Desktop 
Upgrade to Windows 7. 
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2 If you choose At work from the For use list, you will be asked to specify some additional 
information. Parallels needs this information to know our customers better in order to 
provide them with the best software and service. 

 

3 To register Parallels Desktop Upgrade to Windows 7, click OK. 
 

Updating Parallels Desktop Upgrade 
to Windows 7 

Parallels Desktop Upgrade to Windows 7 includes an updating feature that helps you keep your 
Parallels Desktop Upgrade to Windows 7 installation up-to-date. You can use the update feature 
only if your computer is connected to the Internet. 

Update checks can be performed either automatically or manually. 

 We recommend that you turn on automatic updating to be notified when an update is 
available. Parallels Desktop Upgrade to Windows 7 will regularly check for available 
updates and inform you about them. 

 In addition to automatic updating, you can start the updating manually at any time. 
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Automatic Updating 
To use the automatic updating feature, your host computer should have a stable Internet 
connection. 

Parallels Desktop Upgrade to Windows 7 enables you to set up an automatic check for updates 
and determine its frequency. 

To set up automatic update checking: 

1 Open your virtual machine. It should be displayed in the Window view mode (p. 44). 

2 Choose Preferences from the File menu and go to the Update pane. 

3 In the Update pane, you can define the necessary settings. To set up automatic checking for 
new versions, select Check for updates and define the checking frequency. The system can 
search for new updates once a day, once a week, or once a month. With these options set, 
Parallels Desktop Upgrade to Windows 7 will access the Parallels update server and notify 
you when an update is available. If you do not need automatic checking, you can easily turn 
it off by clearing the Check for updates check box. 

Checking for new updates may take some time. If you do not want to have the process 
window on top of your desktop during this time, you can hide it in the background. To do 
that, select Check in background. 

Select Download updates automatically if you want all new available updates to be 
downloaded at once without showing you the Download dialog. 

From the Update pane, you can also perform a manual instant search for updates. To do that, 
click Check Now. The updates available for your version of Parallels Desktop Upgrade to 
Windows 7 will be displayed in the Download dialog. Choose the update(s) you want to 
install and click the Download button. If your version of Parallels Desktop Upgrade to 
Windows 7 is up to date, you will see the corresponding message. 

 

4 When you finish, click OK to save the changes and close the dialog. 
 



 

 Principles of Working with Parallels Desktop Upgrade to Windows 7 18 
 

Manual Updating 
Parallels Desktop Upgrade to Windows 7 also enables you to check for updates manually 
whenever you want. 

To check for updates manually: 

1 Open your virtual machine. It should be displayed in the Window view mode (p. 44). 

2 From the Help menu, choose Check for Updates. The program will immediately start the 
search for updates. 

While the updater accesses the Parallels update server and compares the available updates 
with the installed version, you can hide this window by selecting Check in background. 

3 If there are one or more updates available, they will be listed in the Parallels Update window. 
Select the update to install and click Install. 
You can also download the update by clicking the Download button. To change the 
download folder, type the path into the Download folder field or use the Choose button to 
locate the folder. 

Note: You can install the downloaded update later by locating it in the download folder and 
launching the installer. 

4 Click OK to start the installation. 

5 Follow the Parallels Desktop Upgrade to Windows 7 installer's instructions to install the 
update. 

Note: If the installer displays a list of conflicting applications, quit these applications so you 
can proceed with the installation. 

6 When the update is installed, click Close to quit the installer. 
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Interface Basics 
When you open your Windows-based virtual machine, the Parallels Desktop Upgrade to 
Windows 7 window opens. The Parallels Desktop Upgrade to Windows 7 window consists of 
several parts: 

Menus contain all the controls available for Parallels Desktop Upgrade to Windows 7 and the 
virtual machine. For detailed information, see the Menus subsection (p. 20). 

Toolbar is comprised of buttons that can be used to manage the virtual machine and its 
appearance. For detailed information, see the Toolbar subsection (p. 20). 

Virtual Machine window acts as the virtual machine display. 

Status Bar displays the devices information when the virtual machine is running. For detailed 
information, see the Status Bar subsection (p. 23). 
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Menus 
The Parallels Desktop Upgrade to Windows 7 menus contain all the controls available for 
Parallels Desktop Upgrade to Windows 7 and the Windows-based virtual machine. 

There are the following menus: 

 The File menu allows you to: 
 View and edit the Parallels Desktop Upgrade to Windows 7 Preferences (p. 25); and 

 Quit Parallels Desktop Upgrade to Windows 7. 
 The View menu includes commands for switching between different view modes: the 

Coherence and Window mode. You can also customize how you view the Parallels Desktop 
Upgrade to Windows 7 window and manage certain elements of the Windows desktop such 
as the Start menu, the Windows taskbar, desktop, and recycle bin. 

 The Virtual Machine menu allows you to: 
 Manage the virtual machine (p. 39); 

 Edit the virtual machine configuration; 

 Install Parallels Tools (p. 45); 

 Update Parallels Tools (p. 48); and 

 Compress virtual hard disks (p. 57). 
 The Devices menu is available only when the virtual machine is running. It allows you to 

configure certain devices and shared folders at runtime. 
 The Help menu allows you to: 

 Open Parallels Desktop Upgrade to Windows 7 Help; 

 Activate Parallels Desktop Upgrade to Windows 7 (p. 14); 

 Register Parallels Desktop Upgrade to Windows 7 (p. 15); 

 Check for updates (p. 18); and 

 Report problems (p. 102). 

It also displays the About Parallels Desktop Upgrade to Windows 7 dialog. 
 

Toolbar 
The Parallels Desktop Upgrade to Windows 7 toolbar has buttons for the most frequent 
commands used to start, stop, and otherwise manage a virtual machine and its window 
appearance. 

Most of the toolbar buttons are enabled only when you start the virtual machine. If you click a 
toolbar button, it becomes visibly pressed. 
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The default toolbar buttons: 

 Start. Use this button to start the virtual machine if it is stopped, paused, or suspended. 

 Shut Down. Use this button to shut down your guest OS correctly. 

 Configure. Use this button to open the Virtual Machine Configuration dialog. 

 Coherence. Use this button to switch from the Window view mode to Coherence (p. 44). 

You can easily add other buttons to the toolbar. Just right-click the toolbar, choose Customize 
Toolbar (p. 22) from the shortcut menu, and drag the items you need to the toolbar. 

 Restart. Use this button to restart the fully loaded guest operating system. 

 Pause. Use this button to pause the virtual machine when you need to instantly release 
the Parallels physical server resources used by this virtual machine. 

 Stop. Use this button to stop the virtual machine when the machine does not run properly 
and prevents you from shutting it down. 

Note: If you click this button when the virtual machine is running, you may lose all unsaved 
data. To turn off the virtual machine, use the shutdown procedure specified for the guest OS 
installed in it or use the Shut Down button. 

 Reset. Use this button for hard reset of your virtual machine when the machine does not 
run properly and prevents you from resetting it properly. 
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Customizing Toolbar 

To change the appearance of the toolbar items, right-click the toolbar and use the shortcut menu 
commands: 

 Icon & Text. Use this command if you want the toolbar to display both the button icons and 
their names. 

 Icon Only. Use this command if you want the toolbar to display only the button icons. 
 Text Only. Use this command if you want the toolbar to display only the button names. 
 Use Small Size. Use this command if you want the toolbar buttons to appear in a smaller 

size. 
 Remove Item. Point to a toolbar item and use this command if you want to remove this item 

from the toolbar. 
 Customize Toolbar. This command opens the toolbar settings pane. See the description 

below. 

To customize the set of toolbar buttons and its appearance, right-click the toolbar and choose 
Customize Toolbar from the shortcut menu. The toolbar settings pane will open. You can use this 
pane to: 

 Add new buttons to the toolbar by dragging them from the settings pane to the toolbar; 
 Remove buttons from the toolbar by dragging them from the toolbar to the settings pane; 
 Add separators to the toolbar by dragging them from the settings pane to the toolbar; 
 Add spaces to the toolbar by dragging them from the settings pane to the toolbar; 
 Change the current toolbar buttons set to the default set one by dragging it to the toolbar; 

and 
 Select the toolbar buttons view mode in the Show list. 

To apply the changes you have made to the toolbar settings pane, click Done. 
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Status Bar 
The status bar consists of three parts: 

 The virtual machine devices 

 The view mode menu  

 The virtual machine state menu  

The Virtual Machine Devices 

In the virtual machine status bar, you can find the list of devices connected to the virtual 
machine. This list is available only when the virtual machine is running. By default, the virtual 

machine devices list is hidden. To see the list, click the left arrow button  near the Configure 

button . 
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The following devices have the icons on the status bar: 

 keyboard  

 floppy disk drive  

 CD/DVD drive  

 hard disk  

 network adapter  

 sound card  

 USB controller  

 shared folders  

 serial port  

 printer port  

If you see the  icon in the status bar, it means that Parallels Tools (p. 45) are old and need to 
be updated. 

If a device can be connected or disconnected at runtime (most of the devices can be), this can be 
done using the device's shortcut menu. Click the device icon to display its shortcut menu and 
select the command. The picture below shows the shortcut menu for the CD/DVD drive. 
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You can also connect CD/DVD discs or images of discs to the virtual machine's CD/DVD drive 
or connect a floppy image to its floppy drive in the following way: drag the required image file 
over the CD/DVD drive icon on the Parallels Desktop status bar. For more information, refer to 
the Changing Configuration at Runtime section (p. 49). 

To add devices to the virtual machine configuration or remove them from the configuration, 

click the Configure button . For detailed information, see Adding and Removing Devices 
(p. 93). 

The View Mode Menu 

To change the virtual machine view mode, you can use the View Mode menu  in the 

status bar. Click the down arrow button  and select the desired view mode from the menu. For 
detailed information on the view modes, see Changing the View Mode. 

The Virtual Machine State Menu 

You can start, shut down, or otherwise manage the virtual machine state using the Virtual 
Machine State menu  in the status bar. Click the Virtual Machine State button  and 
select the desired command from the menu. 
 

Setting Parallels Desktop Upgrade 
to Windows 7 Preferences 

Common preferences for the Parallels Desktop Upgrade to Windows 7 program and the 
Windows XP virtual machine can be configured using the Preferences dialog. You can open this 
dialog by choosing Preferences from the File menu. 
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General Preferences 
In the General pane of Parallels Desktop Upgrade to Windows 7 Preferences, you can do the 
following: 

 enable detailed log messages 
 restore hidden messages 

 

Enabling Verbose Logging 

While functioning, Parallels Desktop automatically creates a log file that can be used by the 
Parallels support team for solving problems and improving the product. If you select the Use 
detailed log messages option, Parallels Desktop will start creating a more detailed log file. It can 
be helpful for the Parallels support team, but uses more hard disk space, and may slightly lower 
the system performance. 

Resetting Hidden Messages 

Some Parallels Desktop Upgrade to Windows 7 dialogs and wizard windows are provided with 
the Do not show this message again option. If you select this option, the corresponding dialog 
will not appear next time you perform the same operation. Using the Reset Hidden Messages 
button, you can reset all dialogs and wizard windows with this option selected so that they 
would be displayed again each time you initiate the corresponding operation. 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Keyboard Preferences 
In the Keyboard pane of Parallels Desktop Upgrade to Windows 7 Preferences, you can set 
keyboard shortcuts for certain commands. 

 

You can define the following hot key combinations: 

 For switching a guest OS window to the Coherence mode and back. The default hot key 
combination is Ctrl+Shift+Enter. 

 For releasing the keyboard and mouse input to the primary OS. The default hot key 
combination is Ctrl+Alt. 

You can set your own hot key combinations for each scenario. The key combination must 
include a key and one or several modifier keys (Ctrl, Alt, or Shift). 

To define a new key combination, do the following: 

1 Select one or several modifier keys. 

2 To add an ordinary key, double-click the Key field and press the corresponding key on the 
keyboard. 

Note: If you installed Parallels Tools (p. 45), you can release the mouse and the keyboard input 
to the primary OS without pressing the hot key combination. See the Capturing and Releasing 
the Keyboard and the Mouse section (p. 43). 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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USB Preferences 
In the USB pane of Parallels Desktop Upgrade to Windows 7 Preferences, you can specify how 
to connect USB devices that are plugged into your physical computer. 
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General Behavior 

You can choose a general action to perform when a new USB device is plugged into the host 
computer by choosing one of these options: 

 Connect it to the computer. If you select this option, the USB device plugged into the host 
computer will be connected to the host computer. 

 Connect it to the active virtual machine. If you select this option, the USB device plugged 
into the host computer will be automatically connected to the virtual machine that is 
currently running on the host computer. When no virtual machine is running, the USB 
device will be connected to the primary OS. 

 Ask me what to do. If you select this option, you will be prompted to choose the way you 
want to connect the USB device each time a new USB device is plugged into the host 
computer. 

Permanent Assignments 

You can also set permanent assignments for certain USB devices. These assignments are 
displayed in the Permanent assignments list. 

To add a new assignment: 

1 Click the Add button  below the Permanent assignments list. 

2 Click the device field in the USB Device column to choose a USB device from the list. 

3 In the Connect To column, double-click the destination field to open the list of available 
destinations and choose the virtual machine to which you want to connect this device. If you 
want to connect this USB device to the host computer, choose Computer. 

Note: To be able to use the USB device in a virtual machine, you may need to install the 
necessary drivers in its guest OS. By default, such drivers can be obtained from the 
manufacturers of this device. 

4 Click OK to apply the changes. 

Note: You can connect up to eight USB 2.0 devices and up to eight USB 1.1 devices to each 
virtual machine. 

You can change an assignment by editing the device and destination in the USB Device and 
Connect To fields. 

To remove an existing assignment, select it in the Permanent assignments list and click the 

Remove button . 

For more information about using USB devices in a virtual machine, refer to Using USB Devices 
in a Virtual Machine (p. 54). 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Network Preferences 
The Network pane of Parallels Desktop Upgrade to Windows 7 Preferences allows you to 
configure a number of network-related settings for Parallels Desktop Upgrade to Windows 7 and 
the Windows XP virtual machine. 
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You can configure the range of IP addresses to be assigned to your virtual machine when it is 
operating in the shared (p. 97) and host-only (p. 100) networking modes. 

To edit the host-only networking settings: 

1 Select Host-only networking in the Connection type list. 

2 Select the Enable DHCP Server option to enable the Parallels DHCP server. This server will 
automatically assign an IP address to your virtual machine operating in the host-only 
networking mode from the IP addresses range defined in the appropriate fields below this 
option. 

3 If necessary, configure the start and end IP addresses in the Start address and End address 
fields and specify the network mask in the Subnet mask field. 

For more information on configuring the host-only networking parameters, refer to Host-
Only Networking (p. 100). 

To edit the shared networking settings: 

1 Select Shared networking in the Connection type list. 

2 Select the Enable DHCP Server option to enable the Parallels DHCP server. This server will 
automatically assign an IP address to your virtual machine operating in the shared 
networking mode from the IP addresses range defined in the appropriate fields below this 
option. 

3 If necessary, configure the start and end IP addresses in the Start address and End address 
fields and specify the network mask in the Subnet mask field. 

For more information about configuring shared networking, refer to Shared Networking (p. 
97). 

The Start address and End address values determine the first and the last IP addresses with the 
first address usually assigned to the DHCP server itself. The second address is usually given to 
the host OS. The scope of IP addresses defined should belong to the same subnet. 

Port Forwarding 

Normally, the virtual machine set to operate in the shared networking mode cannot be accessed 
from external computers. The port forwarding functionality allows computers on your local 
network and on the Internet to transfer data to the virtual machine that uses the shared 
networking mode. The data sent to a specific port on the host computer will be redirected to a 
specific port of your virtual machine according to a port-forwarding rule. 

To add a new port forwarding rule: 

1 Click the Add button  below Port forwarding list. 
2 In the displayed window, do the following: 

 In the Port Type field, specify the port type you want to use for establishing network 
connections. You can choose between the TCP or UDP port types. 

 In the Incoming Port field, provide the port number on the host computer you want to use 
for data transfer. 

 In the IP Address field, indicate your virtual machine's IP address. 
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 In the Destination Port field, type the virtual machine port to which the data will be 
transferred. 

3 Click OK to add the rule. 

When the rule is added, use the following IP address combination for external connections to 
your virtual machine: <your physical computer IP address>:<Incoming 
port>. 

 

To edit an existing port forwarding rule, select it in the Port forwarding list table, click the Edit 
button , and modify the necessary parameters in the displayed window. 

To remove a port forwarding rule, select it in the Port forwarding list table and click the Remove 

button . 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Memory Preferences 
The Memory pane of Parallels Desktop Upgrade to Windows 7 Preferences allows you to adjust 
the maximum amount of physical memory (RAM) that the system will reserve for the virtual 
machine running on your physical computer. 

 

By default, the Automatically option is selected. In this case, the total amount of RAM to be 
allocated to the running virtual machine is automatically calculated by the system based on the 
following main factors: 

 the total amount of memory installed on your physical computer, and 
 the amount of memory required by the primary operating system for its operation. 

You can redefine the default behavior and manually set the amount of memory to be reserved 
for the active virtual machine. To this effect, select the Manually option and specify the needed 
value by: 

 dragging the slider, or 
 using the spin box arrows, or 
 typing the value directly into the field. 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Update Preferences 
In the Update pane of Parallels Desktop Upgrade to Windows 7 Preferences, you can set 
preferences for the frequency of update checks. 
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The Check for updates section defines the policy for updating the Parallels Desktop Upgrade to 
Windows 7 software. By default, Parallels Desktop Upgrade to Windows 7 is set to 
automatically check for available updates once a week, provided that Parallels Desktop Upgrade 
to Windows 7 is launched and your physical computer is connected to the Internet. You can 
specify another interval for checking for updates by selecting the necessary value in the Check 
for updates list. The following options are available: 

 Once a day. Select this option if you want Parallels Desktop Upgrade to Windows 7 to 
perform the update check every day. 

 Once a week. Select this option if you want Parallels Desktop Upgrade to Windows 7 to 
perform the update check every week. 

 Once a month. Select this option if you want Parallels Desktop Upgrade to Windows 7 to 
perform the update check every month. 

Checking for new updates may take some time and, if you do not want to have the process 
window on the top of your Desktop, you can hide it to the background. To do that, enable the 
Check in background option. 

Select the Download updates automatically option if you want all new available updates to be 
downloaded at once without showing you the Download dialog. 

You can also check for available updates manually at any time you want by clicking the Check 
Now button: 

 If any updates are available for you version of Parallels Desktop Upgrade to Windows 7, 
you will see them in the Download dialog. Choose the updates you want to install and click 
the Download button. 

 If your version of Parallels Desktop Upgrade to Windows 7 is up to date, you will see the 
corresponding message. 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Feedback Preferences 
Using the Feedback pane, you can join the Parallels Customer Experience Program. 

 

If you choose to participate in the program, Parallels will collect information about your host 
computer and virtual machine configuration. The collected information will help us to make the 
product better fit your needs. 

If you join, only the following types of data will be collected: 

 hardware configuration of the host computer; 
 software configuration of the host computer and virtual machine (software installed in it); 
 configuration file of the virtual machine; 

Any types of private information like your name, e-mail, address, phone number, and keyboard 
input will not be collected. 

For more details, visit the Customer Experience Program page at the Parallels website (follow 
the link in the pane). 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Proxy Server Preferences 
The Proxy Server pane of Parallels Desktop Upgrade to Windows 7 Preferences allows you to 
configure a number of proxy server-related settings. 
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If you do not want Parallels Desktop Upgrade to Windows 7 to use a proxy server for network 
connections, select the Do not use proxy server option and click OK. 

If you want Parallels Desktop Upgrade to Windows 7 to use a proxy server for network 
connections, you have the following options: 

 You can choose the Specify a proxy server option and provide the proxy server settings 
manually. 
If you choose the Specify a proxy server option, you should specify the address and port of 
the proxy server. If this proxy server requires authentication, select the Proxy server requires 
authentication option and type the corresponding credentials in the User Name and Password 
fields. Choose the Use a different proxy server for SSL connections option if you want to use 
an SSL proxy server for your secure connections. Click the SSL Proxy button and provide 
the SSL proxy server address and port in the SSL Proxy window. In this window, you can 
also provide the credentials for accessing this server if needed. If you clear the Use a 
different proxy server for SSL connections option, the first proxy server specified in this pane 
will be used for all connections. 

 In a Windows host operating system, you can choose the Use Internet Explorer proxy settings 
option to import the proxy server setting from the Connections settings of Internet Explorer. 
If you choose the Use Internet Explorer proxy settings option, click OK to apply the changes. 

 In a Windows host operating system, you can also choose the Use automatic configuration 
script option to automatically configure the proxy server settings. 
If you choose the Use automatic configuration script option, you should provide the path to 
this script in the Address field. Then click OK to apply the changes. 

Restoring Default Settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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This chapter explains how to start, stop, reset or pause the virtual machine. It also provides the 
information on actions you can perform with the virtual machine while the guest operating 
system is running. 
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Working in the Virtual Machine 
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Performing Main Operations on a 
Virtual Machine 

Starting Your Virtual Machine and Shutting It Down 

Starting the Virtual Machine 

To start the virtual machine, open it by clicking Start -> All Programs -> Parallels -> Parallels 
Desktop -> Use Windows XP and then do one of the following: 

 Click the Start button  on the Parallels Desktop Upgrade to Windows 7 toolbar or 
 Choose Start from the Virtual Machine menu. 

You can also start the Windows-based virtual machine by launching a program set to work in 
the virtual machine or opening a file with a program set to work in the virtual machine. In these 
cases, the virtual machine will start in the Coherence view mode (p. 44). 

Note: It will take some time (about 2-3 minutes) to launch a program set to work in the 
Windows XP virtual machine if you launch this program for the first time since you turned on 
your computer. 

After starting the virtual machine, it will boot into the guest operating system installed in this 
virtual machine. 

Shutting Down the Virtual Machine 

To turn off the virtual machine, switch the virtual machine to the Window view (p. 44) mode and 
do one of the following: 

 Use the standard shutdown procedure for the guest operating system installed in your virtual 
machine; 

 Click the Shut Down  button in the Parallels Desktop Upgrade to Windows 7 toolbar; 
or 

 Choose Shut Down from the Virtual Machine menu. 
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Pausing Your Virtual Machine 
Pausing a virtual machine releases the resources, such as RAM and CPU, currently used by this 
virtual machine. The released resources can then be used by the host computer and its 
applications. 

Note: Only the amount of RAM used by the guest OS will be released. The memory used by the 
Parallels Desktop Upgrade to Windows 7 application will still be locked. 

To pause a virtual machine, do one of the following: 

 Click the Pause button  in the Parallels Desktop Upgrade to Windows 7 toolbar; or 
 Choose Pause from the Virtual Machine menu. 

When a virtual machine is paused, its window is grayed out. To continue running the virtual 

machine, click the Resume button  in the Parallels Desktop Upgrade to Windows 7 
toolbar, or choose Resume from the Virtual Machine menu. 

Parallels Desktop Upgrade to Windows 7 is designed to operate like an ordinary computer 
application. This means that you do not have to change the virtual machine's state from running 
to paused or stopped before putting the host computer to sleep. In sleep mode, the host computer 
does not allocate any resources to the running applications (including Parallels Desktop Upgrade 
to Windows 7 and the Windows virtual machine) so that they are stopped automatically. As you 
start the host computer, all the applications are automatically up and running again. 
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Stopping and Resetting a Virtual Machine 

Stopping a Virtual Machine 

If the guest operating system cannot be shut down correctly, you can forcibly stop the virtual 
machine by doing one of the following: 

 Click the Stop button  in the toolbar (p. 20); or 
 Choose Stop from the Virtual Machine menu. 

Warning: If you forcibly stop a virtual machine, you may lose all unsaved data. 

Resetting a Virtual Machine 

If some program error has caused your virtual machine to hang, you may wish to reset it. 

To reset a virtual machine, do one of the following: 

 Click the Reset button  in the toolbar (p. 20). If this button is absent from the toolbar, 
refer to the Customizing Toolbar subsection (p. 20) of Parallels Desktop Upgrade to 
Windows 7 User's Guide. 

 Choose Reset from the Virtual Machine menu. 

Warning: If you reset a virtual machine, you may lose all unsaved data. 
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Using Keyboard and Mouse 

Capturing and Releasing the Keyboard and Mouse 
To start working in a virtual machine, you need first to capture the keyboard and mouse input in 
the virtual machine. To this effect: 

1 Move the mouse pointer over the virtual machine window; 

2 Click in the window. 

When the keyboard and mouse input is captured in the virtual machine, you cannot move the 
pointer out of the virtual machine window and all keystrokes and button clicks go to the virtual 
machine. To release the keyboard and mouse back, press Ctrl+Alt. The keyboard and mouse will 
be released immediately. 

Note: You can change the key combination for releasing the keyboard and mouse input using 
the Keyboard pane (p. 27) of the Preferences dialog. 

If you want to automatically capture and release the keyboard and mouse input, you should 
install Parallels Tools (p. 45) in your virtual machine. After the Parallels Tools installation, you 
can capture and release the mouse and keyboard input more easily: 

 Click anywhere in the virtual machine window to capture the input; 
 Click anywhere outside the virtual machine window to release the input. 

 

Keyboard Shortcuts in a Virtual Machine 
If when working in a virtual machine, you press a special key combination intended for the 
guest OS (for example, Ctrl+Alt+Del), the primary operating system may intercept such a 
command. That is why you can apply any of the main Windows shortcuts to your virtual 

machine with the help of the Keyboard icon  in the virtual machine status bar (p. 23). Just 
click the icon and select the desired key combination from the drop-down list. The 
corresponding action will take place in your guest OS and your primary OS will ignore this 
event. 
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Changing the View Mode 
Parallels Desktop Upgrade to Windows 7 provides a number of view modes to make your work 
with virtual machines more comfortable and efficient: 

 Coherence mode. In this mode, the virtual machine desktop is invisible so that you can see 
the windows of virtual machine programs in Windows 7 and work with them side by side 
with your Windows 7 programs. If you start a program switched to work in the Windows-
based virtual machine, or open a file using a program switched to work in the Windows-
based virtual machine, the virtual machine will start in the Coherence view mode. 

 Window mode. In this mode, the virtual machine screen is displayed in the Parallels Desktop 
Upgrade to Windows 7 window. If you start the Windows-based virtual machine by clicking 
Start -> All Programs -> Parallels -> Parallels Desktop -> Use Windows XP, the virtual 
machine will start in the Window view mode. 

Switching Between the Coherence and Window Modes 

The Coherence mode provides the highest level of integration between the host and the guest 
operating systems. In this mode, you can have any programs running under these operating 
systems on one desktop. For more information on the Coherence mode, see Working in the 
Coherence Mode (p. 45). 

To switch a running virtual machine from the Window view mode to Coherence, do one of the 
following: 

 Click the Coherence button  in the Parallels Desktop Upgrade to Windows 7 toolbar. 
 Select Coherence from the View menu. 
 Use the appropriate hot key combination (Ctrl+Shift+Enter by default). 

Note: The default hot key combinations can be configured on the Keyboard pane (p. 27) of 
the Preferences dialog. 

To switch the virtual machine from the Coherence view mode to the Window view mode, use 
the appropriate hot key combination (Ctrl+Shift+Enter by default). 
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Working in the Coherence Mode 
Coherence is a visual mode of working with a virtual machine that enables you to use your guest 
OS programs side by side with the host OS programs. 

When a virtual machine with one or more running programs is working in the Coherence mode, 
you will see the windows of the guest OS programs on your host OS desktop along with the 
windows of the host OS programs. 

Using Windows Guest OS Start Menu 

When working in the Coherence mode, you may need to access the guest OS Start menu. To this 
effect, do the following: 

1 Point the mouse to the host OS Start menu and the sign of the guest OS Start menu will pop 
up above. 

2 Click this sign and the guest OS Start menu will open. 
 

Installing Parallels Tools 
Parallels Desktop Upgrade to Windows 7 includes a set of specially developed utilities that help 
you use your virtual machine in the most comfortable and efficient way. 

Parallels Tools are located on the disc image that is installed along with Parallels Desktop 
Upgrade to Windows 7: 

 prl-tools-win.iso - disc image with Parallels Tools for Windows guest operating 
systems. 

This disc image can be found in the following folder: 

 In 32-bit Windows: C:\Program Files\Parallels\Parallels 
Desktop\Tools 

 In 64-bit Windows: C:\Program Files (x86)\Parallels\Parallels 
Desktop Upgrade to Windows 7\Tools\ 
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Parallels Tools Overview 
Parallels Tools are a suite of special utilities that help you use your virtual machine in the most 
comfortable and efficient way. With Parallels Tools, you can move the mouse seamlessly 
outside the guest OS window without pressing any key, change the virtual machine's screen 
resolution by simply resizing its window, synchronize your virtual machine's time and date 
settings with the time settings of the host computer, and share the host computer disks and 
folders with the virtual machine. 

Parallels Tools include the utilities listed below. 

Mouse Synchronization Tool Windows Mouse Synchronization Tool captures the mouse 
input in the virtual machine each time the pointer 
moves over to the guest OS window and 
automatically releases the input when the pointer 
moves out of the guest OS window. 

Time Synchronization Tool Windows Time Synchronization Tool enables you to customize 
your virtual machine and the host computer time 
settings. With this tool, you can: 

 Automatically synchronize the time settings of 
your virtual machine with the host computer time 
settings. 

 Set up and maintain the time difference between 
your host computer and the guest OS. 

Clipboard Synchronization 
Tool 

Windows Clipboard Synchronization Tool enables you to easily 
exchange texts between the virtual machine and the 
host computer. 

Dynamic Resolution Tool Windows Dynamic Resolution Tool enables you to work with 
dynamic resolution. When you resize the guest OS 
window by dragging its lower right corner, the guest 
OS window resolution changes automatically. 

Shared Folders Tool Windows Shared Folders Tool enables you to share the primary 
OS folders to access them from the guest OS. With 
this tool, you can access the host computer shared 
folders from the virtual machine. 

Shared Profile Tool Windows Shared Profile Tool enables you to map some of the 
folders in the physical computer home folder to your 
user folders in the virtual machine, which allows you 
to access the physical computer home folders right 
from your virtual machine. 

Parallels Compressor Windows The Parallels Compressor utility enables you to 
reduce the size of your virtual machine's hard disk. 

After the Parallels Tools installation, the following features are available for setting up in 
Parallels Desktop Upgrade to Windows 7. 

SmartMount Windows SmartMount feature enables the automatic detection 
and mounting of removable devices in your virtual 
machines. 
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Installing Parallels Tools in a Windows Guest OS 
Parallels Tools are usually installed automatically after your Windows-based virtual machine 
boots up after the first start. 

However, if the automatic installation does not begin, do the following to install Parallels Tools 
in the virtual machine: 

1 Start the virtual machine and log in to the guest operating system. 

2 When the guest OS boots up, connect the Parallels Tools ISO image by choosing the Install 
Parallels Tools option from the Virtual Machine menu. 

3 In the Welcome window, click Install. The wizard will start the automatic installation. 

4 When the installation is complete, click Reboot to exit the wizard and restart the virtual 
machine. 

If the aforementioned ways do not work and you cannot install Parallels Tools, try to do the 
following: 

1 Start the virtual machine and log in to the guest operating system. 

2 When the guest OS boots up, connect the Parallels Tools ISO image by right-clicking the 
CD/DVD-ROM icon in the virtual machine's window status bar and choose Connect Image. 

3 Open the following folder: 

 In 32-bit Windows: C:\Program Files\Parallels\Parallels Desktop 
Upgrade to Windows 7\Tools\ 

 In 64-bit Windows: C:\Program Files (x86)\Parallels\Parallels 
Desktop Upgrade to Windows 7\Tools\ 

Select the prl-tools-win.iso file, and click Open to connect it to the virtual machine. 

4 In the virtual machine, open My Computer and double-click the Parallels Tools disc icon to 
expand its contents. 

Note: If the installation wizard does not launch automatically, right-click the disc, choose 
Open from the shortcut menu, and double-click Setup.exe to launch the installer. 

5 Follow the wizard's instructions to complete the installation. 

To edit the settings of Parallels Tools installed in your virtual machine, use the Services pane (p. 
63) of the Virtual Machine Configuration dialog. 

How to Check If Parallels Tools are Installed 

If you are not sure whether Parallels Tools are installed, you can easily check this. Start your 
virtual machine and look at the status bar of its window. If the tip "Press Ctrl + Alt to 
release the mouse and keyboard" appears in the status bar of the virtual machine's 
window, this means that Parallels Tools are not installed. When Parallels Tools are installed, 
you do not need to press any key to release the mouse and keyboard - they are released 
automatically. 
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Updating Parallels Tools 
Parallels Desktop Upgrade to Windows 7 automatically checks for new Parallels Tools updates 
when you start your virtual machine. 

If a newer version of Parallels Tools is available, you will see the corresponding message 
offering you the option to download and update the tools. Click Yes to download Parallels Tools 
from the Parallels Update server and install them into your virtual machine. Updating will start 
right after the download finishes and will prompt you to restart the virtual machine when it is 
complete. 

If you do not want to update Parallels Tools or want to do it later, click No. You will be able to 
update them later by using the Update Parallels Tools option from the Virtual Machine menu. 

If Parallels Tools are up-to-date but you want to reinstall them, select the Reinstall Parallels 
Tools option from the Virtual Machine menu. 
 

Removing Parallels Tools 
Parallels Tools can be removed through a general procedure of removing applications from the 
operating system installed in your virtual machine: 

1 Start the virtual machine and log in to the guest OS. 

2 From the Windows Start menu, choose Control Panel > Add or Remove Programs. 

3 Select Parallels Tools in the list and click Remove. 

4 When Parallels Tools are removed, restart the guest operating system. 
 



 

 Working in the Virtual Machine 49 
 

Changing Configuration at Runtime 
Parallels Desktop Upgrade to Windows 7 allows you to connect or disconnect certain devices at 
runtime or switch some of them for using other media. 

Generally, the following virtual devices can be connected or disconnected at runtime: 

 CD/DVD-ROM drive 
 Floppy disk drive 
 Network adapter 
 Printer port 
 Serial port 
 Sound device 
 USB device 
 Generic SCSI device 
 Shared folders 

You can configure any of these devices in one of the following ways: 

 Use the necessary command from the Devices menu in the menu bar. This menu is available 
only when the virtual machine is running. 

 Click a device icon on the status bar (p. 23) and choose the command from a device shortcut 
menu. 
The status bar displays the devices information when the virtual machine is running. 

 Drag an image file (*.iso or *.fdd) or a shared folder on the appropriate device icon in the 
status bar. This option is available only for CD/DVD-ROM drives, floppy drives, and shared 
folders. 

Connecting a CD/DVD-ROM or a Floppy Drive 

If you have several CD/DVD-ROM drives connected to your virtual machine, they are listed in 
the same order as they were connected in the Devices menu. The first CD/DVD-ROM drive will 
be CD/DVD-ROM 1, the second will be CD/DVD-ROM 2, and so on. 

Connecting a Network Adapter 

You can connect the network adapter to your virtual machine. If you have several network 
adapters used by the virtual machine, they are listed in the same order as they were connected on 
the status bar (p. 23) and in the Devices menu. The first network adapter will be Network Adapter 
1, the second will be Network Adapter 2, and so on. 

Connecting a Printer Port 

To connect or disconnect a printer port or connect a printer or an output file to a printer port, do 
the following: 

 Click the Devices menu, select the corresponding printer port, and choose the appropriate 
command from the displayed menu. 
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 Right-click the printer port icon  in the status bar (p. 23) to display the shortcut menu 
and choose the appropriate command. 

Connecting a Serial Port 

To connect or disconnect a serial port, do the following: 

 Click the Devices menu, select the corresponding serial port, and choose the appropriate 
command from the displayed menu. 

 Right-click the serial port icon  in the status bar (p. 23) to display the shortcut menu and 
choose the appropriate command. 

Connecting a Sound Device 

To connect or disconnect a sound device, choose the Activate or Mute options respectively. You 
can also choose the type of output and input devices. 

Connecting a USB Device 

Parallels Desktop Upgrade to Windows 7 automatically detects all USB devices plugged into the 
host computer. The devices that are currently connected to the virtual machine appear in the list 
from the Device menu. You cannot use a USB device in the host operating system while it is 
being used by the virtual machine. 

Connecting a Shared Folder 

The Shared Folders options available at runtime are similar to the Shared Folders settings in the 
Virtual Machine Configuration dialog. 

You can: 

 Share all disks of the host computer or Home folder only with the virtual machine. 
 Add a new shared folder. 

 

Using Devices 

Setting Up a Printer in a Virtual Machine 
There are four basic ways to set up printing in a virtual machine. You can: 

 Share a host computer's printer (p. 51). 
 Use a network printer (p. 52). 
 Set up printing via LPT port of the physical computer (p. 53). 
 Set up a USB printer (p. 53). 
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Sharing a Host Computer's Printer 

You can share any printer connected to the physical computer with your Windows-based virtual 
machine. The printer will be available through the virtual machine's printer port. 

To share the physical computer's printer: 

1 Open your Windows-based virtual machine. It should be displayed in the Window view 
mode (p. 44). 

2 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. Select the Hardware tab and make sure the configuration includes a printer port. If 
necessary, add it. See Adding and Removing Devices (p. 93). 

3 In the Printer Port pane, make sure the Connected option is selected if you want the printer to 
be automatically connected on the virtual machine startup. 

4 From the Source menu, choose your printer. 

Click OK to close the Virtual Machine Configuration dialog. 

5 Start the virtual machine. 

6 In a Windows guest OS, if you have Parallels Tools installed (p. 47), the HP Color LaserJet 
8500 PS printer is automatically connected to your virtual machine and you can use it at 
once. If you do not have Parallels Tools installed in your Windows guest OS, no matter what 
type of printer you have, install the HP Color LaserJet 8500 PS printer driver and then 
follow the procedure of adding a printer in a guest OS described below. 

Warning: Do not install the driver from the installation CD, supplied with your printer, in the 
virtual machine. 

Adding a Printer in a Windows Guest Operating System 

To add a printer in a Windows guest OS: 

1 Start the Windows virtual machine and log in as administrator. 

2 Open the Windows Start menu, select Control Panel. 
3 In the Control Panel window, select the Printers and Faxes item. 

4 Double-click the Add a printer link to open the Add Printer wizard. 

5 In the Add Printer wizard: 

1. Click Next in the wizard's first dialog. 

2. In the Local or Network Printer dialog, click Local printer attached to this computer. 
6 Continue with the general installation procedure and install the HP Color LaserJet 8500 PS 

printer driver. 
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Setting Up a Network Printer 

You can install a network printer directly into a guest OS. 

Before installing a network printer in a guest OS, make sure that: 

 Networking in the primary and guest OSs is configured. 
 The virtual machine network adapter is connected to the virtual machine. To do this: 

1. Open the virtual machine. It should be displayed in the Window view mode (p. 44). 

2. Select Configure from the Virtual Machine menu. 

3. Select the Hardware tab and click the Network Adapter item. 

4. Make sure the Connected option is selected. If it is cleared, select this option and click 
OK. 

 The user account in the guest OS from which you are going to set up the printer has 
permissions to access the network printer. 

 You know the printer's IP address. 

After that, you can log into the guest OS and install a network printer. 

In a Windows Guest Operating System 

Before adding a network printer to Windows, download and install an appropriate printer driver. 

To add a network printer in your Windows guest operating system: 

1 Choose Control Panel from the Start menu in your guest OS. 

2 Click Printers and Faxes. 

3 Click the Add printer icon. 

4 In the Add Printer wizard introduction window, click Next. 
5 Select the Local printer attached to this computer option and disable Automatically detect and 

install my Plug and Play printer. 
6 Select Create a new port and specify Standard TCP/IP port as the port type. 

Click Next. 
7 In the next window, specify the printer's IP address and click Next. 
8 If prompted to specify additional port information, choose Standard and select Generic 

Network Card from the list. 

9 In the next window, click Finish. 

10 In the Install Printer Software window, specify the manufacturer of the driver and select the 
model of the network printer. 

If the required printer model is not listed, click the Have Disk button and specify the path to 
the .inf file in the driver installation folder. 

When finished, click Next. 
11 Follow the wizard's instructions to complete the installation. 
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Setting Up Printing via LPT Port of Physical Computer 

To set up printing through a parallel port of your physical computer: 

1 Make sure that a printer is connected to an LPT port of your real computer. 

2 Open your virtual machine. It should be displayed in the Window view mode (p. 44). 

3 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. Select the Hardware tab and make sure the configuration includes a printer 
port. If necessary, add it. See Adding and Removing Devices (p. 93). 

4 In the Printer Port pane, make sure the Connected option is selected. 

5 Choose the necessary real printer port from the Source menu. 

6 Click OK and start the guest operating system. 

7 Install the native driver for your printer in the guest OS. 
 

Setting Up a USB Printer 

To set up a USB printer: 

1 Start your virtual machine. It should be displayed in the Window view mode (p. 44). 

2 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. Select the Hardware tab and make sure the configuration includes a USB 
controller. If necessary, add it. See Adding and Removing Devices (p. 93). 

3 Start the virtual machine. 

4 When the guest OS boots up, plug the USB printer in the host computer. See Using USB 
Devices in a Virtual Machine (p. 54). 

5 Install the native driver for the printer in the guest OS. 
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Using USB Devices in a Virtual Machine 
To connect a USB device to your virtual machine, you should add a USB controller to the 
virtual machine configuration. 

By default, when you plug a USB device into the host computer, the New USB Device dialog 
asks if you want to connect this device to the host computer or to the virtual machine. 

 Click Host Computer if you want to use this USB device in the host operating system. 
 Click Virtual Machine if you want to use this USB device in the virtual machine. 

Note: If you select to connect the detected USB device to the virtual machine and then reboot 
this virtual machine, the New USB Device dialog will not appear again after the reboot. The USB 
device will still be connected to this virtual machine. 

If you want Parallels Desktop Upgrade to Windows 7 to remember your choice, select 
Remember this association. The next time you plug this USB device into the host computer, it 
will be automatically connected to the destination you specified in this dialog. To change the 
destination, use USB preferences in the Preferences dialog (p. 25). 

 

If you do not want Parallels Desktop Upgrade to Windows 7 to display this dialog each time a 
USB device is plugged into the host computer, configure USB preferences in the Preferences 
dialog (p. 25). 

To be able to use the USB device in the virtual machine, you may need to install the necessary 
drivers in the guest OS. By default, such drivers can be obtained from the manufacturers of this 
device. 
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Using Shared Folders 
Shared folders are folders in the host computer operating system that are visible to the guest OS 
too. These folders can be used for exchanging files between the host computer operating system 
and the virtual machine. 

In the primary OS shared folders appear as usual folders. While in the guest OS, they are objects 
of the network neighborhood. 
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Setting Up a Shared Folder 
Setting up a shared folder requires two steps: 

1 Installing Parallels Tools in the guest OS. The Shared Folders tool is required for viewing 
the shared folders in the guest OS. See Installing Parallels Tools (p. 45). 

2 Adding one or more shared folders to the virtual machine configuration. 

Adding a Shared Folder 
1 Make sure the virtual machine is switched to the Window view mode (p. 44). 

2 Open the virtual machine configuration by choosing Configure from the Virtual Machine 
menu. 

3 In the Virtual Machine Configuration dialog, select the Options tab and click Shared Folders. 

4 Click the  button to open the Shared Folder Properties window. 

5 In the Shared Folder Properties window: 

 Make sure the Enabled option is selected. 

 Click the Path menu, select Choose a folder, and locate the folder that you want to be 
shared with the virtual machine. 

 In the Name field, type the shared folder name under which the folder will be accessible 
from inside the virtual machine. 

 In the Description field, you can provide a brief description for the shared folder. 

 Select the Read-only option if you want the shared folder to have a read-only status when 
accessed from inside the virtual machine. 

 Click OK. 

 

6 Click OK in the Virtual Machine Configuration dialog. 
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Viewing Shared Folders in Guest OS 
There are the following ways to view the contents of the shared folders in the guest OS: 

Easy Way 

Click the Parallels Shared Folders icon on the desktop of the running guest OS, and you will see 
all your shared folders. 

General Way 
1 In the virtual machine, open Windows Explorer. 
2 In Explorer, select My Network Places, then select Entire Network, and find Parallels Shared 

Folders. 

3 Click Parallels Shared Folders to view the list of shared folders available in your virtual 
machine. 

Note: To be able to write to a shared folder inside a virtual machine, make sure that the Read 
Only check box (p. 66) for this folder is cleared in the Virtual Machine Configuration dialog. 
 

Compressing Virtual Hard Disks 
If you use an expanding (p. 84) virtual hard disk in your virtual machine, its image file size on 
the physical hard disk increases as you add new data to the virtual hard disk. When you delete 
some data from this virtual hard disk, free unused space appears on the disk. But the amount of 
space your virtual machine occupies on the hard disk of the host computer does not decrease. To 
free the unused space back to the host computer, you can compress the virtual hard disk. The 
hard disk image file size will be decreased and, as a result, there will be more free space on the 
hard disk of the host computer. 

You can compress virtual hard disks either manually or automatically: 

 To compress the virtual hard disk manually at any time, select Configure from the Virtual 
Machine menu, click Hardware, select Hard Disk, and click the Compress button. 

 To regularly free the unused space back to the host computer, use the AutoCompress option. 
The virtual hard disk in an expanding format will be reviewed twice a day. If the unused 
space occupies more than 50 percent of the hard disk image size, it will be compressed, and 
the hard disk image file size will be decreased. The AutoCompress option can be enabled for 
all hard disks of a virtual machine in the Optimization pane of the Virtual Machine 
Configuration dialog. 
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This chapter provides the information on configuration options available to your virtual 
machine. You can configure the virtual machine in the Virtual Machine Configuration dialog. To 
open this dialog, choose Configure from the Virtual Machine menu. 

In This Chapter 
General Settings .................................................................................................................... 58 
Options .................................................................................................................................. 59 
Hardware ............................................................................................................................... 76 
Adding and Removing Devices............................................................................................. 93 
Networking in a Virtual Machine.......................................................................................... 96 
 
 

General Settings 
On the General tab, you can view and change the virtual machine name, processors number, 
amount of memory, and other general settings: 

 

C H A P T E R  5  

Configuring the Virtual Machine 
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 Name. In this field, you can view and change the virtual machine's name. It is displayed in 
the virtual machine's main window (p. 19) and limited to 50 characters. 

 The guest OS type and version. This field, located right under the Name field, displays the 
type and version of the guest operating system installed in the virtual machine. 

 Processors. In this menu, you can view the number of host computer CPUs the virtual 
machine can use. 

 Main memory. In this field, you can set the amount of RAM that will be available to the 
virtual machine. You can choose any available value, but it is recommended that you set the 
value provided in the Recommended range below the slider. 

 Notes. In this field, you can type any additional information related to the virtual machine. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 

Options 

Startup and Shutdown Settings 
Using the Startup and Shutdown settings, you can define a number of parameters related to the 
procedures of starting and shutting down your virtual machine. 
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Starting the Virtual Machine Automatically 

The Start automatically option defines the cases in which the virtual machine can be started 
automatically. 

 Select Never if you do not want your virtual machine to be started automatically in any case. 
 Select When window opens if you want your virtual machine to start automatically when you 

open it. 
 Select When Parallels Desktop starts if you want your virtual machine to start automatically 

every time you start Parallels Desktop Upgrade to Windows 7. 

Startup View 

The Startup view option defines the mode in which the virtual machine will work after you start 
it. If the Window or Coherence option is selected, the virtual machine will automatically switch 
to the specified view mode. If the Same as last time option is selected, the virtual machine will 
start in the same mode that was applied to it before it was turned off. 

Action on the Virtual Machine Shutdown 

The On shutdown option defines the operation to be performed when you stop the virtual 
machine. 

 Select Keep window open if you want the virtual machine window to stay open after the 
virtual machine is stopped. 

 Select the Close window option if you want the virtual machine window to automatically 
close after the virtual machine is stopped. 

 Select Quit Parallels Desktop if you want to quit Parallels Desktop Upgrade to Windows 7 
after the virtual machine is stopped. 

Action on Closing the Virtual Machine Window 

The On window close option defines the operation to be performed when you close the virtual 
machine's window. 

 Select Stop if you want the virtual machine to be shut down when you close its window. 
 If you select Ask me what to do, you will be prompted to choose the operation to perform 

with the virtual machine each time you close its window. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Optimization Settings 
In the Optimization pane of the Virtual Machine Configuration dialog, you can configure the 
settings related to the virtual machine performance. 
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Adaptive Hypervisor 

Select Enable Adaptive Hypervisor option for Adaptive Hypervisor to automatically allocate the 
host computer CPU resources between the virtual machine and primary OS programs depending 
on what program you are working with at the moment. If the virtual machine window is in 
focus, the priority of this virtual machine processes will be set higher than the priority of the 
primary OS processes. As a result more CPU resources will be allocated to the virtual machine. 
If you switch to the primary OS window, the priority of its working programs will be set higher 
and the CPU resources will be relocated to the primary OS. This Adaptive Hypervisor 
technology is helpful when you use a lot of programs in the primary and guest OSs at the same 
time, and as a result, lack the CPU resources. 

Compressing the Disk Automatically 

If you use an expanding (p. 84) virtual hard disk in your virtual machine, its image file size on 
the physical hard disk increases as you add new data to the virtual hard disk. When you delete 
some data from this virtual hard disk, free unused space appears on the disk but the amount of 
space occupied by your virtual machine on the hard disk of the host computer does not reduce. 
To regularly free the unused space back to the host computer, use the Enable AutoCompress 
option. The virtual hard disk in an expanding format will be reviewed twice a day. If the unused 
space occupies more than 50 percent of the hard disk image size, it will be compressed, and the 
hard disk image file size will be decreased. As a result, there will be more free space on the hard 
disk of the host computer. 

Note: The Enable AutoCompress option is available only for Windows- and Linux-based virtual 
machines with Parallels Tools (p. 45) installed. Compressing can be performed for virtual 
machines without snapshots. 

In the Hard Disk pane (p. 81), you can compress the disk manually whenever you want. 

Tuning Windows for Speed 

You can make your Windows virtual machine work even faster by selecting Tune Windows for 
speed. This option disables some of the additional Windows features that tend to slow down the 
performance of Windows. 

Optimizing Performance 
 Virtual machine. Select this option to allocate more physical computer memory resources to 

the virtual machine and its applications. Selecting this option may significantly increase the 
virtual machine performance. However, it may slow down the productivity of your host 
computer applications. 

 Host computer. Select this option to allocate more memory resources to the host computer 
and its applications. 

Power Consumption (laptops only) 

This group of settings allows you to control the virtual machine power consumption if Parallels 
Desktop Upgrade to Windows 7 is installed on a laptop computer that is running on batteries: 

 Longer battery life. If you select this option, the virtual machine power consumption will be 
automatically reduced to provide a longer life for the battery of your laptop. 
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 Better performance. If you select this option, the virtual machine and its applications will 
operate at the maximum possible speed. However, enabling this option may significantly 
reduce the battery life. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 

Services Settings 
In the Services pane, you can manage the Parallels Tools-related settings. 
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SmartMouse 

The SmartMouse option makes the mouse smoothly move between the virtual machine and the 
operating system of the host computer. 

 If you select On, the mouse input will be automatically captured in the virtual machine 
window when the mouse pointer hovers over it and then released when it moves back to the 
operating system of the client computer. It will make the mouse move seamlessly between 
the client computer and the virtual machine. 

 If you select Off, you will need to click inside the virtual machine window to capture the 
mouse input, and press Ctrl+Alt to release it back to the client computer. 

Note: Ctrl+Alt is the default key combination. You can define another key combination for 
releasing the mouse in the Keyboard pane of Parallels Desktop Upgrade to Windows 7 
Preferences. 

 If you select Auto, the option will automatically become disabled (Off) each time you use a 
game, graphic application, or any other program that uses its own mouse pointer instead of 
using the operating system pointer. The option will be automatically enabled (On) after you 
quit the application. 

Synchronizing Time 

Select the Synchronize with host computer option to synchronize the virtual machine time 
settings with those of the host computer. 

If the time zone specified in your virtual machine differs from the time zone of the host 
computer, you can maintain this time difference by selecting Allow a different time than on host 
computer. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Security Settings 
In the Security pane, you can set restrictions for performing some actions and make your virtual 
machine isolated from Windows 7. 

 

If you want to isolate your virtual machine from Windows 7, select Isolate host from guest. This 
option disables all integration features, including Shared Folders (p. 66), Shared Profile (p. 68), 
Shared Applications (p. 70), Internet Applications (p. 72), and SmartMount (p. 74). You will 
also not be able to copy or move objects between the virtual machine and Windows 7. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 



 

 Configuring the Virtual Machine 66 
 

Shared Folders Settings 
To manage shared folders and their settings, use the Shared Folders pane of the Virtual Machine 
Configuration dialog. 

Note: When you share the host computer disks or folders with a virtual machine, they still reside 
and occupy space on the host computer hard disk. 
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Sharing Parallels Server Disks to Virtual Machine 

In the Share these host computer folders menu, select All disks to provide the virtual machine 
with access to all disks available on the host computer. 

Sharing Host Computer Home Folder 

In the Share these host computer folders menu, select Home folder if you want to access the host 
computer Home folder from the virtual machine. 

Sharing the Host Computer Folders with the Virtual Machine 

To add a host computer folder to be shared with the virtual machine, use the Add button  
under the User-defined host computer folders table. The Shared Folder Properties dialog will 
open. In this dialog, specify the following settings and click OK: 

 Enabled. Select this option to enable the shared folder. 
 Path. In this field, type the path to the folder you want to share with the virtual machine. 

You can use the Choose button to locate the folder. 
 Name. In this field, type the shared folder name that will appear in the virtual machine. 
 Description. In this field, you may type a brief description for this shared folder. 
 Read-only. Select this option if you want this shared folder to have a read-only status when 

accessed from the virtual machine. 

To remove a shared folder, select it and click the Remove button . 

For more information about shared folders, see Using Shared Folders (p. 55). 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 



 

 Configuring the Virtual Machine 68 
 

Shared Profile Settings 
In the Shared Profile pane, you can make the desktop of the host operating system and some of 
the Home folder items accessible directly from the Desktop and the corresponding folders of the 
Windows guest OS. 

Note: To use the functionality available on the Shared Profile pane, you should have Parallels 
Tools (p. 45) installed in the virtual machine and the Isolate host from guest option disabled in 
the Security pane (p. 65). 
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Note: To enable the Shared Profile functionality, you must share all the host computer disks or 
at least the Home folder. You can configure the necessary sharing settings in the Shared Folders 
pane (p. 66). Or you can click OK in this pane to automatically enable the host computer Home 
folder sharing together with enabling Shared Profile. 

If the Shared Profile functionality is activated, you can choose one of the following options: 

 Select Desktop to use the Windows 7 desktop as the desktop in the Windows XP guest 
operating system. 

 Select Documents to use the Windows 7 Documents folder as the My Documents folder 
in the Windows XP guest operating system. 

 Select Pictures to use the Windows 7 Pictures folder as the My Pictures folder in the 
Windows XP guest operating system. 

 Select Music to use the Windows 7 Music folder as the My Music folder in the Windows 
XP guest operating system. 

 Select Videos to use the Windows 7 Videos folder as the My Videos folder in the 
Windows XP guest operating system. 

Warning: If you delete any host computer file from the Windows XP desktop when the host 
computer desktop sharing is enabled, you will not be able to find it in the Windows 7 or 
Windows XP Recycle Bin. The file will be deleted from your computer permanently. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Shared Applications Settings 
Using the Shared Applications settings, you can configure the applications sharing between the 
virtual machine and Windows 7. 

Note: These options are available only when Parallels Tools are installed in the virtual machine 
and the Isolate host from guest option is disabled in the Security pane (p. 65). 
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Windows Applications 

Select Share guest applications with host operating system to allow virtual machine applications 
to open files stored in Windows 7. Before using a virtual machine application in Windows 7 for 
the first time, you should open it once inside the virtual machine. If you enabled this option, you 
can configure the following options: 

 If you select Show Windows applications folder in Start menu, the folder with all programs 
installed in your Windows virtual machine will be always displayed in the Windows 7 Start 
menu. 

 Select the Pause virtual machine when no applications are running option to save your 
Windows 7 resources. Pausing a virtual machine releases the resources, such as RAM and 
CPU, currently used by this virtual machine. The released resources can then be used by the 
host computer and its applications. 
If you select this option, the virtual machine will be automatically paused provided that: 

 The virtual machine is running but the virtual machine window is not active over 30 
seconds. 

 There are no applications running in the guest operating system. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Internet Applications Settings 
1 Using the Internet Applications settings, you can specify the settings for opening different 

types of Internet-related files and locations. 

Note: To use the functionality available in the Internet Applications pane, you should have 
Parallels Tools (p. 45) installed in the virtual machine and the Isolate host from guest option 
disabled in the Security pane (p. 65). 
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You can specify different Internet applications for opening each of the following types of web 
pages: 

 Web pages. Web pages accessible through the HTTP and HTTPS protocols. 
 E-mail. Links in the mailto format. 
 Newsgroups. Links in the news. format. 
 FTP. Locations accessible through the FTP protocol. 
 RSS. RSS feeds. 
 Remote access. Locations accessible through the Telnet and Secure Shell (SSH) 

protocols. 

To set applications for opening these types of web pages and links: 

1 Click the box next to the type name. 

2 Choose the appropriate Internet application from the list. 

Note: This list contains Internet applications installed in Windows 7 and your virtual 
machine. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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SmartMount Settings 
Using the SmartMount settings, you can automate the detection and mounting of removable 
devices in your virtual machine. 

Note: To use options available in this pane, you should have Parallels Tools installed in the 
virtual machine and the Isolate host from guest option disabled in the Security pane (p. 65). 
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To enable the SmartMount feature, you should select Enable SmartMount in this pane and select 
one or several types of devices to mount. 

If the SmartMount functionality is enabled and you connect a device of the selected type to the 
host computer, this device is also automatically mounted to your guest operating system as a 
network drive. 

The following devices can be automatically mounted to the virtual machine: 

 Removable drives. Select this option if you want external storage devices such as USB hard 
disks and USB flash drives to be mounted to your guest OS. 

 CD/DVD drives. Select this option if you want CD and DVD drives or CD/DVD images to be 
mounted to your guest OS. 

 Network folders. Select this option if you want network shares connected to the host 
computer to be mounted to your guest OS. 

The permissions you will have for managing the mounted device from inside the virtual 
machine will coincide with those you have for this device on the host computer. So, if you can 
read from, and write to, a USB flash drive on the host computer, you will have the same 
permissions for this drive from inside the virtual machine. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 

Coherence Settings 
The Coherence pane of the Virtual Machine Configuration dialog allows you to configure the 
following settings: 
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Share Windows 7 system tray with the virtual machine. This option allows you to share the 
Windows 7 system tray with the system tray of your virtual machine when it is working in the 
Coherence view mode (p. 44). If you select this option, the icons available in the system tray of 
the virtual machine working in the Coherence view mode (p. 44) will also be available in the 
system tray in Windows 7. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 

Hardware 

Boot Order Settings 
To set the boot sequence for your virtual machine, use the Boot Order pane of the Virtual 
Machine Configuration dialog. 
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When the virtual machine starts, it can use one of these boot devices: 

 Hard Disk. Select this device if you want the virtual machine to boot up from its virtual hard 
disk. 

 CD/DVD. Select this device if you want the virtual machine to boot up from the media 
connected to its CD/DVD-ROM drive. 

Note: The virtual machine will use the CD/DVD-ROM specified as CD/DVD-ROM 1 in the 
virtual machine configuration. 

 Floppy Disk. Select this device if you want the virtual machine to boot up from the media 
connected to its floppy disk drive. 

 Network Adapter. Select this device if you want the virtual machine network adapter to use a 
PXE server for booting. 

Note: The virtual machine will use the network adapter specified as Network Adapter 1 in the 
virtual machine configuration. 

When the virtual machine starts up, it is trying to boot from the device that appears as the first 
device in this list. If the device has no media or it is not bootable, the virtual machine proceeds 
to the next device in the sequence, and so on. 

To change the booting sequence, select a device and move it using the arrows. 

To remove a device from the sequence, clear the check box next to its name. 

If you select the Select boot device on startup option, you will see the following message at the 
virtual machine startup: "Press ESC to select boot device". If you press ESC 
pending 5 seconds, you will be able to select a boot device. If you do not press ESC, the virtual 
machine will try to boot from the devices specified in the Boot order list. 

Note: Make sure that the device you wish to use for your virtual machine booting (hard disk 
drive, CD-ROM drive, floppy disk drive, or network adapter) is available to the virtual machine 
and configured properly. If you do not have any boot devices configured in your virtual 
machine, you will see the following error message after you start the virtual machine: “No 
boot device is available”. In this case, you should stop the virtual machine and 
configure at least one boot device for it. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Video Settings 
To set the amount of video memory available to the virtual machine video card, use the Video 
pane of the Virtual Machine Configuration dialog. 

 

In the Video memory field, you can set the amount of video memory that will be available to the 
virtual machine. You can specify any value from 2 to 256 MB. 

To set the video memory limit, do one of the following: 

 Drag the slider; 
 Use the spin box arrows; or 
 Type the value directly into the Video memory field. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Floppy Settings 
To view and edit the virtual machine floppy disk drive settings, use the Floppy Disk pane of the 
Virtual Machine Configuration dialog. 

 

Select the Connected option if you want the floppy disk drive or floppy disk image to be 
automatically connected to the virtual machine on its startup. 

In the Source field, you should specify the source device or image file that will emulate the 
virtual machine floppy disk drive: 

 If you want to use a real floppy disk drive, click the Source field and select the real device 
name from the list. 

 If you want to use a floppy disk image, click the Source field and choose the virtual machine 
default floppy.fdd file. Or you can click Choose an image file and specify the path to the 
desired floppy disk image file. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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CD/DVD-ROM Settings 
To configure the virtual machine's CD/DVD-ROM drive settings, use the CD/DVD-ROM pane of 
Virtual Machine Configuration. Virtual CD/DVD-ROM drives can be connected either to 
physical CD/DVD-ROM drives or to CD/DVD images. 

 

Select the Connected option if you want the CD/DVD-ROM drive to be automatically connected 
to the virtual machine on its startup. 

In the Source field, the source device or image file that emulates the virtual machine CD/DVD 
drive is specified. You can change the source device: 

 To use a real CD/DVD drive as the virtual machine CD/DVD drive, click the Source field 
and select the real device name from the list. 

 To use an image file as the virtual machine's CD/DVD drive, click the Source field and 
choose the image file from the list or click Choose an image file and specify the path to the 
desired image file. 

In the Location field, you can specify the type of interface for connecting the device. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Hard Disk Settings 
To view and configure the virtual hard disk settings, use the Hard Disk pane of Virtual Machine 
Configuration. The current version of Parallels Desktop Upgrade to Windows 7 allows the 
virtual machine to use hard disk images in the .hdd format. 
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In the Source field, the virtual hard disk file (.hdd) that emulates the virtual machine hard disk 
is specified. To use a virtual hard disk file as the virtual machine hard disk, click the Source 
field and choose the virtual hard disk file from the list or click Choose an image file and specify 
the path to the desired image file (.hdd). 

In the Location field, you can specify the type of interface for connecting the device. 

Compressing the Disk 

If you use an expanding (p. 84) virtual hard disk in your virtual machine, its image file size on 
the physical hard disk increases as you add new data to the virtual hard disk. When you delete 
some data from this virtual hard disk, free unused space appears on the disk. But the amount of 
space your virtual machine occupies on the hard disk of the host computer does not reduce. To 
free the unused space back to the host computer, click the Compress button. The virtual hard 
disk will be compressed and the hard disk image file size will be decreased. As a result, there 
will be more free space on the hard disk of the host computer. 

Note: Compressing is available only for the virtual machine with Parallels Tools (p. 45) 
installed. 

On the Optimization pane of Virtual Machine Configuration, you can enable regular automatic 
disk compression. 

Resizing Virtual Hard Disks 

To reduce or increase the virtual hard disk size, use the Resize button. If you click this button, 
the following window will be displayed: 
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To reduce the virtual hard disk size, you can do one of the following: 

Note: Reducing dynamic disks is not supported. 

 If the virtual hard disk image is blank, specify a new size and click OK. 
 If the virtual hard disk already has a file system, specify a new size, select Resize file 

system, and click OK. 

To increase the virtual hard disk size, you can do one of the following: 

 If the virtual hard disk image is blank, specify a new size and click OK. 
 If the virtual hard disk already has a file system, specify a new size and click OK. In this 

case, the added space will be unallocated. You will have to create a logical drive or a 
partition on the unallocated space and then format the newly created drive or partition. 

 If the virtual hard disk already has a file system, specify a new size, select Resize file 
system, and click OK. In this case, you will not have to format the added space and it will be 
available to the existing drive. 

 If the virtual hard disk is dynamic, specify the new size and click OK. You will have to 
format the newly added space manually. 

Note: When increasing the dynamic virtual hard disk size, make sure the Resize file system 
option is not selected. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Support for Virtual and Real Disks 

This section lists the types of disks that can be used by the Parallels virtual machine and 
provides the information about basic operations you can perform on these disks. 

Supported Types of Hard Disks 

The Parallels virtual machine uses virtual hard disks as their hard disks. 

Virtual Hard Disks 

The capacity of a virtual hard disk can be set from 100 MB to 2 TB. 

Virtual hard disks can be of either plain or expanding format. 

Plain A plain virtual hard disk image file has a fixed size.  The size is determined when the 
disk is created. Plain disks can be created with the help of New Virtual Machine wizard 
(the Custom mode.)  

Expanding An expanding virtual hard disk image file is small initially. Its size grows as you add 
applications and data to the virtual hard disk in the guest OS. 

Split Disks 

A virtual disk of either format can be a single-piece disk or a split disk. A split disk is cut into 2 
GB pieces and is stored as a single .hdd file. 

CD/DVD Discs and Their Images 

Parallels Desktop Upgrade to Windows 7 can access real CD/DVD discs and images of 
CD/DVD discs. 

Parallels Desktop Upgrade to Windows 7 has no limitations on using multisession CD/DVD 
discs. Virtual machine can play back audio CDs without any limitations on copy-protected discs. 

Parallels Desktop Upgrade to Windows 7 supports CD/DVD disc images in the ISO format. 
Parallels Desktop Upgrade to Windows 7 may also support CD/DVD disc images in the CUE 
and CCD formats. 

Floppy Disks and Floppy Disk Images 

Parallels Desktop Upgrade to Windows 7 can use two types of floppy disks: 

 Real diskettes inserted into a real floppy disk drive that is connected to the virtual machine. 
 Floppy disk image files with the .fdd extension connected to the virtual machine. 

Parallels Desktop Upgrade to Windows 7 treats floppy disk images like real diskettes. Parallels 
Desktop Upgrade to Windows 7 supports floppy disk image files that have .fdd extension and 
1.44 MB size. 

With Parallels Desktop Upgrade to Windows 7, you can also create an image of a blank floppy 
using Floppy Disk pane (p. 79) of the Virtual Machine Configuration dialog. 
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Note: Parallels Desktop Upgrade to Windows 7 cannot create images of real diskettes. 
 

Network Adapter Settings 
In the Network Adapter pane of the Virtual Machine Configuration dialog, you can configure the 
virtual machine network settings. 
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Select the Connected option if you want the virtual machine to start up with this network adapter 
connected. 

You can choose one of the following types of networking for the virtual machine network 
adapter: 

 Shared Networking. Select this option to enable the Network Address Translation (NAT) 
feature for the virtual machine. In this case, your virtual machine will share whatever 
network connection is currently used by the host computer. 
See Shared Networking (p. 97) to learn how to configure this type of networking. 

 Bridged Networking. Select this option to allow the virtual machine to access the local 
network and Internet through one of the network adapters installed on the host computer. In 
this case, the virtual machine is treated as a stand-alone computer on the network and should 
be configured in the same way as a real one. You can choose the physical adapter where the 
virtual machine adapter will be bridged in the list below the Bridged Networking option. 
See Bridged Ethernet Networking (p. 99) to learn how to configure this type of networking. 

 Host-Only Networking. Select this option to allow the virtual machine to connect to the host 
computer and the virtual machines residing on it and to make it invisible outside the host 
computer. 
See Host-Only Networking (p. 100) to learn how to configure this type of networking. 

Changing Virtual Machine MAC Address 

In the MAC address field, you can change the MAC address currently assigned to the virtual 
machine. MAC addresses are automatically generated during the virtual machine creation. 
However, you can modify the default MAC address by typing another value in the MAC address 
field or clicking the Generate button. When entering a new MAC address, make sure that it is 
unique within your network. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Printer Port Settings 
In the Printer Port pane of the Virtual Machine Configuration dialog, you can configure the virtual 
machine printer port settings. A virtual machine can have up to three printer ports. 
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Select the Connected option if you want the virtual machine to start up with the printer port 
connected. 

In the Source field, the source device that emulates this printer port is specified. A printer port 
can be emulated by one of the following devices: 

 Default Printer. You can use any of the printers connected to the host computer in your 
virtual machine. Click the Source field and select the appropriate printer from the list. 
By default, the HP Color LaserJet 8500 PS printer supporting PostScript is installed in 
Windows virtual machines, irrespective of the real printer model and version. In most cases, 
modern printers support PostScript and that is why you should disregard the printer name 
you see in the Windows printing wizard and complete the procedure. 

 Real Printer Port. If the host computer has a physical printer port, you can connect it to your 
virtual machine. Click the Source field and select the physical port name from the list. 

 Output File. You can emulate the virtual machine printer port by using an output file. Click 
the Source field and choose an output file from the list, or click Choose an output file and 
specify the path to the desired output file on the host computer. 

Printing to Non-PostScript Printers 

If you connect a printer that does not support PostScript to your virtual machine, select Print to 
non-PostScript printers to be able to print to this printer. However, you also need to install 
Ghostscript in Windows 7. For details, please follow the link in the Printer Port pane. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 



 

 Configuring the Virtual Machine 89 
 

Sound Settings 
In the Sound pane of the Virtual Machine Configuration dialog, you can configure the sound 
device settings. 

 

Select the Connected option to have the sound device automatically connected on the virtual 
machine startup. 

Use the Input list to choose the necessary device. You can choose one of the following devices: 

 Default. Select this option if you want to use the input device set as default on the host 
computer. 

 Null device. Select this option if you want to mute the input device. 

Use the Output list to choose the necessary device. You can choose one of the following devices: 

 Default. Select this option if you want to use the input device set as default on the host 
computer. 

 Null device. Select this option if you want to mute the output device. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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USB Settings 
In the USB Controller pane, you can see the USB devices currently connected to the virtual 
machine. 

A virtual machine can emulate only one USB controller, which provides you with the possibility 
to connect USB devices to the virtual machine. 
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Serial Port Settings 
In the Serial Port pane, you can configure the virtual machine serial port settings. 

Using serial ports, you can establish a connection between the virtual machine and the host 
computer devices (using a real port). 

If you want to connect your virtual machine to the host computer device, you should create a 
serial port emulated by a real port. The Source list comprises the devices on the host computer 
that are available for connection. The connected device, being used in the virtual machine, 
cannot be used by the host computer. To be able to use it in the host computer, you should first 
disconnect it from the virtual machine. To do that, use the virtual machine status bar (p. 23). 

If you need to log the performance activity of your virtual machine or to record the data from it 
and use this information later on, you can connect your virtual machine serial port to an output 
file on the physical server. You will be able to view and analyze the activity history of the 
virtual machine any time you need it by exploring this file. 

 



 

 Configuring the Virtual Machine 92 
 

Select the Connected option if you want the virtual machine to start up with the serial port 
connected. 

In the Source field, the source device that emulates this serial port is specified. Serial ports can 
be emulated by the following devices: 

 Real Port. If the host computer has a physical serial port, you can connect it to your virtual 
machine. Click the Source field and select the physical port name from the list. 

 Output File. If you want to connect the virtual machine serial port to an output file, click the 
Source field and choose an output file from the list, or click Choose an output file and 
specify the path to the desired output file on the host computer. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
 

Generic SCSI Device Settings 
To view and edit the settings of a generic SCSI device used by the virtual machine, use the 
Generic SCSI pane of the Virtual Machine Configuration dialog. 

The SCSI device list displays the SCSI devices available in the hardware configuration of the 
host computer. You can change the device connected to the virtual machine by choosing another 
device from the list. 

You can also change the device position in the Location list. 

Note: The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 
controller itself. 

You may add a brief description of the device in the Description field. 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration dialog. 
If you do not want to save the changes, click Cancel. 
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Adding and Removing Devices 
Adding new devices to a virtual machine is easier than connecting new devices to a real 
computer. Removing or disconnecting devices is also easy. The following virtual devices can be 
added to the configuration or removed from it: 

 virtual hard disk drive 
 CD/DVD drive 
 floppy disk drive 
 network adapter 
 serial port 
 printer port 
 sound device 
 USB controller 
 generic SCSI device 

Any of the aforementioned devices can be added to the corresponding virtual machine only 
when it is stopped. 

Note: To be able to connect any virtual device to a real one, you should have system privileges 
to access the real device. Otherwise, the real device will not appear in the list of available 
devices even though it is installed on your computer. 

Adding a New Device to a Virtual Machine 
1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 

dialog. 

2 Go to the Hardware tab. 

3 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog and 
select the device to be added to the virtual machine. 

Note: The Add button is disabled when the virtual machine is running. You need to stop the 
virtual machine before you can use this button. 
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4 If you selected any device except for a hard disk, the corresponding device with a typical 
configuration will be added at once and ready to use. 

However, if you select a hard disk, you will have to specify the following parameters: 

 The hard disk type: a new image file or an existing one. 

 The hard disk location. Provide the path to the existing image file or the path and name 
for the new image file. By default, Parallels Desktop Upgrade to Windows 7 offers to 
save the new image file in the virtual machine PVM bundle (p. 10). 

 The hard disk size for the new hard disk image file. 

 For the new hard disk image file, you can choose one of the following formats: 
Expanding or Plain. By default, the hard disk will have the Expanding format. To create 
a Plain hard disk, clear the Expanding disk option. If you want the virtual hard disk to be 
split, select the Split the disk image into 2 GB files option. For more information on hard 
disk formats, refer to Support for Virtual and Real Disks (p. 84). 
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Click OK, to add the hard disk. After you added a new virtual hard disk to the virtual 
machine configuration, it will be invisible to the operating system installed inside the virtual 
machine until you initialize the disk. For detailed information on how to do it, refer to 
Initializing the Newly Added Disk (p. 95). 

After a new device is added, you can start using it in the virtual machine. If the typical settings 
of the device do not meet your requirements, you can configure them at any time. For more 
information on configuring the settings of the virtual machine devices, refer to the Hardware 
section. 

Removing Devices from the Virtual Machine Configuration 
1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 

dialog. 

2 Go to the Hardware tab. 

3 Select the device you want to remove and click the Remove button  in the bottom part of 
the Virtual Machine Configuration dialog. 

Note: If you accidentally click the Remove button , click Cancel in the Virtual Machine 
Configuration dialog. Once you click OK, the device will be removed. 
 

Initializing the Newly Added Disk 
After you added a new blank virtual hard disk to the virtual machine configuration, it will be 
invisible to the operating system installed inside the virtual machine until the moment you 
initialize it. 

Initializing the New Virtual Hard Disk in Windows 

To Initialize the new virtual hard disk in a Windows guest OS, you will need the Disk 
Management utility available through: 

 Windows XP: Start > Control Panel > Administrative Tools > Computer Management > 
Storage > Disk Management. 

When you open the Disk Management utility, it automatically detects that a new hard disk was 
added to the configuration and launches Initialize and Convert Disk Wizard: 

1 In the introduction window, click Next. 
2 In the Select Disks to Initialize window, select the newly added disk and click Next. 
3 In the Select Disks to Convert window, select the newly added disk and click Finish. 

The added disk will appear as a new disk in the Disk Management utility window, but its 
memory space will be unallocated. To allocate the disk memory, right-click this disk name in 
the Disk Management utility window and select New Volume. The New Volume Wizard window 
will appear. Follow the steps of the wizard and create a new volume in the newly added disk. 

After that your disk will become visible in My Computer and you will be able to use it as a data 
disk inside your virtual machine. 
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Networking in a Virtual Machine 
To configure networking in your virtual machine, you should first configure networking for 
Parallels Desktop Upgrade to Windows 7. You should also configure Parallels Desktop Upgrade 
to Windows 7 networking with the ability to send problem reports and get Parallels Desktop 
Upgrade to Windows 7 updates. If you have a network connection on your physical computer 
and do not use a proxy server, the Parallels Desktop Upgrade to Windows 7 network connection 
is set automatically. If you use a proxy server for network connections on your host computer, 
you should provide this proxy server setting in the Proxy Server pane (p. 37) of Parallels 
Desktop Upgrade to Windows 7 Preferences. 

After establishing networking for Parallels Desktop Upgrade to Windows 7, you should 
configure networking for your virtual machine. Parallels Desktop Upgrade to Windows 7 allows 
you to use the following types of networking in your virtual machines: 

 Shared Networking (p. 97). This type of networking allows the virtual machine to use the 
current network connections of your physical computer. 

 Bridged Ethernet (p. 99). This type of networking allows the virtual machine to use one of 
the physical computer's network adapters, which makes it appear as a separate computer on 
the network to which the physical computer belongs. 

 Host-Only Networking (p. 100). This type of networking allows the virtual machine to access 
only the host computer. 

By default, the virtual machine uses Shared Networking because configuring it requires minimal 
effort from the users. The Bridged Ethernet networking mode is more complex, and you may 
need to contact your system administrator to set it up properly. 

Detailed information on these types of networking and the way to configure them is provided in 
the following subsections. 
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Shared Networking 
If the virtual machine is set to work in the Shared Networking mode, it can access other 
computers on your local network and the Internet by using the IP address of the physical 
computer. The virtual machine itself does not have its own IP address on the network. This 
mode allows you to specify port forwarding rules (p. 30) for the virtual machines running on the 
host computer, which can be especially useful when running HTTP, FTP, or other types of 
servers in the virtual machine. 
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The Shared Networking mode does not require any additional configuration. With this mode 
enabled, your virtual machine will share whatever network connection your physical computer 
uses at the moment. 

You may wish to use the Shared Network mode in the following cases: 

 Your computer accesses the Internet via a modem or another non-Ethernet device. 
 You need to access the Internet from inside your virtual machine but are concerned about 

security. 
 You have problems with working in the Bridged Ethernet mode. 

To configure your virtual machine to use Shared Networking: 

1 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. 

2 Select Network Adapter on the Hardware tab. 

3 In the Network Adapter pane, make sure that the Connected option is selected. 

4 Choose Shared Networking from the Type menu. 

5 In the MAC address field, you can change the MAC address currently assigned to the virtual 
machine. MAC addresses are automatically generated during the virtual machine creation. 
However, you can modify the default MAC address by typing another value in the MAC 
address field or clicking the Generate button. When entering a new MAC address, make 
sure that it is unique within your network. 

Note: You can modify the default MAC address only when the virtual machine is stopped. 

6 Click OK. 

For the information about troubleshooting networking problems, refer to the Parallels 
knowledge base http://kb.parallels.com/ available at the Parallels website. 
 

http://kb.parallels.com/�
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Bridged Ethernet Networking 
When operating in the Bridged Ethernet mode, your virtual machine appears on the network as a 
stand-alone computer with its own IP address and network name. 

Note: The Bridged Ethernet networking mode is more complex than the Shared Networking 
mode (p. 97), and you may need to contact your system administrator to configure it properly. 

 

To configure your virtual machine to work in the Bridged Ethernet mode: 

1 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. 

2 Select Network Adapter on the Hardware tab. 

3 In the Network Adapter pane, make sure that the Connected option is selected. 

4 Click the Type menu and select an appropriate network adapter under the Bridged 
Networking list. To connect the virtual machine's adapter to the active network adapter of 
your physical computer, choose Default Adapter. 

5 In the MAC address field, you can change the MAC address currently assigned to the virtual 
machine. MAC addresses are automatically generated during the virtual machine creation. 
However, you can modify the default MAC address by typing another value in the MAC 
address field or clicking the Generate button. When entering a new MAC address, make 
sure that it is unique within your network. 

Note: You can modify the default MAC address only when the virtual machine is stopped. 

6 Click OK. 

If you cannot configure your virtual machine to function in the Bridged Ethernet mode, you can 
consider using another networking mode: Shared Networking (p. 97) or Host-Only Networking 
(p. 100). 

For the information about troubleshooting networking problems, refer to the Parallels 
knowledge base http://kb.parallels.com/ available at the Parallels website. 
 

http://kb.parallels.com/�
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Host-Only Networking 
Parallels Desktop Upgrade to Windows 7 provides a closed network that is accessible only to 
the primary operating system. The primary operating system is connected to this network via the 
Parallels Host-Only Networking adapter automatically created on the physical computer during 
the Parallels Desktop Upgrade to Windows 7 installation. The address for the virtual machine 
connected to this network is provided by the Parallels DHCP server. 

 

To configure your virtual machine to use Host-Only Networking: 

1 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. 

2 Select Network Adapter on the Hardware tab. 

3 In the Network Adapter pane, make sure that the Connected option is selected. 

4 Choose Host-Only Networking from the Type menu. 

5 In the MAC address field, you can change the MAC address currently assigned to the virtual 
machine. MAC addresses are automatically generated during the virtual machine creation. 
However, you can modify the default MAC address by typing another value in the MAC 
address field or clicking the Generate button. When entering a new MAC address, make 
sure that it is unique within your network. 

Note: You can modify the default MAC address only when the virtual machine is stopped. 

6 Click OK. 

For the information about troubleshooting networking problems, refer to the Parallels 
knowledge base http://kb.parallels.com/ available at the Parallels website. 
 

http://kb.parallels.com/�
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This chapter describes how to troubleshoot known issues. 

In This Chapter 
Getting Technical Support .................................................................................................... 101 
Reporting a Problem to the Parallels Team........................................................................... 102 
Problems with Antivirus Software ........................................................................................ 103 
 
 

Getting Technical Support 
Our friendly technical support team is ready to help. Describe your problem and submit a FREE 
request to Parallels Support Team (http://www.parallels.com/support/). 

To find solutions to common problems, explore Parallels Knowledge Base 
(http://kb.parallels.com/). This online resource includes valuable articles about using Parallels 
Desktop Upgrade to Windows 7. 

Telephone support is available on a per incident fee basis. Please visit the support team's page of 
the Parallels web site for details. 
 

C H A P T E R  6  

Troubleshooting and Limitations 

http://www.parallels.com/support/�
http://kb.parallels.com/�
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Reporting a Problem to the Parallels 
Team 

To help improve the quality of Parallels Desktop Upgrade to Windows 7, you can send problem 
reports to the Parallels support team. If a fatal error occurs in a virtual machine, Parallels 
Desktop Upgrade to Windows 7 automatically opens the Parallels Problem Report window 
prompting you to send a report. If you notice an unusual virtual machine behavior, you can 
create a report manually by choosing Report a Problem from the Help menu and filling out the 
form. Parallels Desktop Upgrade to Windows 7 will create a status report and make a screen 
shot of the running virtual machine. 

Note: Parallels team collects error reports and uses them for identifying performance issues, but 
does not respond to them. If you need assistance in resolving the issue, visit Parallels forum or 
Support page, or log us a support call. 
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In the Specify the problem type field, select your problem from the list. In the next field, you can 
add a short problem description. 

In the Contact Name and Contact e-mail fields, type your name and e-mail. This information will 
be used by the Parallels support team to contact you for more technical details if needed. 

You can review the problem report components that will be sent to the Parallels support team 
and maybe deselect some of them in the Parallels Problem Report Details window. To open this 
window, click Report details. 

Sending a Report 

After you revise the problem report components, click Send Report. The report will receive its 
unique id number and will be sent to the Parallels support team. 
 

Problems with Antivirus Software 
Because of the close integration with the host operating system, some actions performed by the 
Parallels Desktop Upgrade to Windows 7 processes may be detected as malicious by the 
antivirus software installed on the host computer. 

However, such actions are necessary to ensure the proper functioning of Parallels Desktop 
Upgrade to Windows 7. That is why you should prevent the antivirus software from blocking 
them. If you do not want the alerts to appear in future, perform a full system scan using the 
antivirus software and add these processes to the list of trusted ones if no viruses are detected. 
To find out how to do it, refer to your antivirus software Help. 

Note: The names of Parallels Desktop Upgrade to Windows 7 processes usually start with prl 
or parallels. 
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This glossary defines terms and spells out abbreviations used in Parallels Desktop Upgrade to 
Windows 7 documentation. References to terms defined elsewhere in the glossary appear in 
italics. 

Administrator. A user with administrative privileges. 

Activation key. A unique set of symbols that activates the Parallels Desktop Upgrade to 
Windows 7 application on the host computer and lets you use the Parallels Desktop Upgrade to 
Windows 7 functionality to its full extent. 

Bridged networking. Virtual machine network connection mode that enables the virtual machine 
to appear as any other computer on the network, with its own IP address and network name. 

Configuration file. A file specifies the virtual machine's hardware configuration, the devices it 
uses, and other settings. It is created automatically when you create a new virtual machine. See 
also PVS file.  

CPU. Stands for central processing unit. It is an internal part of the computer. See also 
Processor. 

Expanding format. A virtual hard disk format. An expanding virtual hard disk image file resides 
on your host computer and is small initially. Its size grows as you add applications and data to 
the virtual machine. 

FireWire connection. A wired connection that enables a high-speed data transmission between 
computers. 

Guest operating system (guest OS). An operating system installed inside your virtual machine. 

Host computer: The computer that is used to run virtual machines. In case of Parallels Desktop 
Upgrade to Windows 7 for Mac, it is your Mac. In case of Parallels Desktop Upgrade to 
Windows 7 for Windows or Parallels Desktop Upgrade to Windows 7 for Linux, it is the 
Windows- or Linux-based physical computer where Parallels Desktop Upgrade to Windows 7 is 
installed. In the Parallels Transporter documentation, this term may define the computer that 
hosts the result of migration. 

Hot key. A user-defined key or combination of keys that provides quick access to applications 
and commands. See also Shortcut. 

HDD file. During the creation, the virtual machine acquires a virtual hard disk file with the .hdd 
extension. See also virtual hard disk file. 

Host-only networking. Virtual machine network connection mode that creates a private network 
between the host computer and its virtual machines, which makes the virtual machines available 
from the host computer only. 

Glossary 
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ISO Image. A special file that contains the entire contents of a CD or DVD disc commonly used 
to install an operating system. 

Image file. A single file containing the complete contents and structure of a data storage medium 
or device, such as a hard disk drive, CD, or DVD. 

IP address. A unique address that is assigned to a physical computer or a virtual machine that 
participates in computer networking. 

Merged disk. A split disk whose parts were merged into a single disk. 

OS. An operating system. 

Parallels Tools. A set of Parallels utilities that ensures a high level of integration between the 
primary and the guest operating systems. 

Parallels Desktop Upgrade to Windows 7. A program that allows you to smoothly move from 
Windows XP to Windows 7 without losing your files and programs. 

Plain format. A virtual hard disk format. A plain virtual hard disk image file resides on the host 
computer and has a fixed size that cannot be changed. 

Primary operating system (primary OS). Operating system that controls the I/O devices of the 
computer and that is loaded when the physical computer is turned on. It is the operating system 
of the physical computer where the Parallels Desktop Upgrade to Windows 7 application is 
installed. 

Processor. The central processing unit, or CPU. It is an internal part of the computer. 

PVS file. A virtual machine configuration file that contains information about the virtual machine 
resources, devices and other settings. 

Shared networking. Virtual machine network connection mode that allows the virtual machine to 
use the host computer network connections. In this mode, the virtual machine is invisible to 
other computers on the network the host computer belongs to. 

Shortcut. A user-defined key or combination of keys that provides quick access to applications 
and commands. See also Hot key. 

Split disk. A split disk is cut into 2 GB pieces, but is stored as a single HDD file. Split disks 
allow you to transfer the data stored on a split disk piece by piece using a USB drive or other 
media that have limited space and cannot store a large virtual hard disk image file. 

Virtual hard disk (virtual disk). A file or group of files that emulates the virtual machine's hard 
disk. 

Virtual machine. The computer emulated using Parallels Desktop Upgrade to Windows 7. A 
virtual machine has its own virtual hardware and requires an operating system to control its 
hardware. The installed operating system and its applications are isolated inside the virtual 
machine and share physical hardware resources of the host computer. 

Virtual Machine Configuration. Like any physical computer, a virtual machine has its own 
configuration which is set during the creation and can be later modified. The virtual machine 
configuration settings are stored in a PVS file. 
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Virtual machine files. Files stored in a virtual machine folder. A virtual machine has at least two 
files: configuration file and virtual hard disk file. 

Virtual hard disk file. During the creation, the virtual machine acquires a virtual hard disk file 
with the .hdd extension. This file performs the functions of a real hard disk. See also HDD file. 

VM. See Virtual Machine. 

Windows computer. A physical computer that has a Windows operating system installed. 
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managing CD/DVD-ROM drive at runtime 

- 49 
Changing virtual machine configuration at 

runtime - 49 
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and guest OSs - 46 

D 
Default folder for virtual machines - 26 
Devices 

adding devices to virtual machine - 93 
boot sequence - 76 
connecting and disconnecting devices at 

runtime - 49 
DHCP server - 100 
Disconnecting devices at runtime - 49 

E 
Expanding disks - 84 

F 
Files 

sharing files - 66 
Floppy disk drive 

floppy disks and floppy disk images 
supported - 84 

floppy settings - 79 
managing floppy disk drive at runtime - 49 

FreeBSD 
setting up printer in FreeBSD - 52 

G 
General preferences - 26 
Getting support - 101 
Guest operating system 

definition - 6 

H 
Hard disk 

adding hard disk 
initializing newly added hard disk - 95 

hard disk settings - 81 
sharing host computer's hard disks with 

virtual machine - 66 
types of hard disks - 84 

Host-only networking - 100 
Hot keys - 43 

I 
Installing Parallels Tools in guest OSs - 45 

K 
Keyboard 

capturing - 43 
releasing - 43 
shortcuts - 43 

L 
Linux 

Linux guest OSs which support Parallels 
Tools - 46 

removing Parallels Tools from Linux guest 
OSs - 48 

setting up printer in Linux guest OS - 51, 52 
updating Parallels Tools in Linux guest OSs 

- 48 

M 
Mouse 

capturing - 43 
releasing - 43 
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guest OS - 46 

N 
Network adapter 

managing network adapter at runtime - 49 
Network printer - 52 
Networking in virtual machine 
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host-only networking - 100 
shared networking - 97 

P 
Parallel port 

managing parallel port at runtime - 49 
parallel port settings - 87 
setting up printing via parallel port - 53 

Parallels Desktop Upgrade to Windows 7 
Parallels Desktop Upgrade to Windows 7 

preferences - 25 
updating Parallels Desktop Upgrade to 

Windows 7 - 16 
Parallels Tools 

about Parallels Tools - 46 
installing Parallels Tools - 47 
removing Parallels Tools - 48 
updating Parallels Tools - 48 

Pausing virtual machine - 41 
Preferences for Parallels Desktop Upgrade to 

Windows 7 - 25 
Primary operating system 

definition - 6 
Printer, connecting to virtual machine - 50 

R 
Releasing keyboard and mouse - 43 
Resetting virtual machine - 40 
Resuming virtual machine - 41 
Running virtual machines - 39 
Runtime, changing configuration at - 49 

S 
Screen resolutions - 78 
SCSI device 

generic SCSI device settings - 92 
Serial port 

managing serial port at runtime - 49 
serial port settings - 91 

Setting Parallels Desktop Upgrade to Windows 
7 preferences - 25 

Shared folders 
setting up shared folder - 56 
shared folders options - 66 
Shared Folders tool - 46 
using shared folders - 55 
viewing in guest OS - 57 

sharing files - 66 
Shutting down virtual machine - 40 
Socket - 91 
Sound device 

managing sound device at runtime - 49 
sound device settings - 89 

Starting Virtual Machine - 40 

Status bar 
connecting devices in a running Virtual 

Machine - 49 
Suspending virtual machines - 41 

T 
Technical support - 101 
Toolbar - 20 

customizing toolbar - 22 
Troubleshooting - 101 
Turning off virtual machine - 40 

U 
Updating Parallels Desktop Upgrade to 

Windows 7 - 16 
USB device 

managing USB device at runtime - 49 
setting up USB printer - 53 
USB Settings - 90 
using USB devices in virtual machine - 54 

USB printers - 53 

V 
Video settings - 78 
Virtual hard disk 

adding virtual hard disk 
initializing newly added virtual hard disk - 95 

types of virtual hard disks - 84 
virtual hard disk settings - 81 

Virtual machine 
about virtual machines - 10 
adding devices to a virtual machine - 93 
changing virtual machine configuration at 

runtime - 49 
default folder for storing virtual machines - 

26 
performing main operations on virtual 

machine - 40, 41 
setting up printer in virtual machine - 50 
using shared folders in virtual machines - 

55 
using USB devices in virtual machines - 54 

W 
Windows 
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